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Overview of this guide 
The Installation Guide describes how to install the software and configure the environment for the 
InForm application and Cognos 8 Business Intelligence software.  

After installing the software and configuring the environment, use the Study and Reporting Setup Guide 
for information about how to set up a study and the Reporting and Analysis module. 
 

Audience 
This guide is for database and system administrators who are responsible for installing and 
configuring the InForm software and the Cognos 8 Business Intelligence software. 
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Related information 

Documentation 
All documentation is available from the Oracle Software Delivery Cloud 
(https://edelivery.oracle.com) and the Download Center (https://extranet.phaseforward.com). 

 

 

Document Description 

Release Notes The Release Notes document describes enhancements introduced and 
problems fixed in the current release, upgrade considerations, release 
history, and other late-breaking information. 

Known Issues The Known Issues document provides detailed information about the 
known issues in this release, along with workarounds, if available. 

Note: The most current list of known issues is available on the 
Extranet. To sign in to the Extranet, go to 
https://extranet.phaseforward.com. 

Upgrade and Migration Guide The Upgrade and Migration Guide provides instructions for upgrading and 
migrating the InForm software and InForm Portal software to the 
current InForm release, and for upgrading the Cognos 8 Business 
Intelligence software for use with the Reporting and Analysis module. 
The guide also describes any changes and additions made to the 
database schema, MedML, and resource files. 

Secure Configuration Guide The Secure Configuration Guide provides an overview of the security 
features provided with the Oracle® Health Sciences InForm application, 
including details about the general principles of application security, 
and how to install, configure, and use the InForm application securely. 

Installation Guide The Installation Guide describes how to install the software and 
configure the environment for the InForm application and Cognos 8 
Business Intelligence software.  

Study and Reporting Setup 
Guide 

The Study and Reporting Setup Guide describes how to perform the tasks 
that are required to set up an InForm study and configure the 
Reporting and Analysis module for the study. 

User Guide The User Guide provides an overview of the InForm application 
including details on multilingual studies, how to navigate through the 
user interface, and how to use the application to accomplish typical 
tasks you perform while running a clinical study.  

This document is also available from the Documentation CD and the 
InForm user interface. 
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Document Description 

Reporting and Analysis Guide The Reporting and Analysis Guide provides an overview of the Reporting 
and Analysis module. It includes a brief overview of the Reporting and 
Analysis interface, illustrates how to access the Ad Hoc Reporting 
feature, and describes the study management and clinical data packages 
available for Reporting and Analysis. It also provides detailed 
descriptions of each standard report that is included with your 
installation. 

This document is also available from the Documentation CD. 

Reporting Database Schema 
Guide 

The Reporting Database Schema Guide describes the Reporting and 
Analysis database schema, and provides information on creating 
Reporting Database Extracts (RDEs). 

Portal Administration Guide The Portal Administration Guide provides step-by-step instructions for 
setting up the InForm Portal software, and configuring and managing 
the InForm Portal application. 

This document is also available from the Documentation CD. 

Utilities Guide The Utilities Guide provides information about and step-by-step 
instructions for using the following utilities: 

• PFConsole utility 

• MedML Installer utility 

• InForm Data Import utility 

• InForm Data Export utility 

• InForm Performance Monitor utility 

• InForm Report Folder Maintenance utility 

This guide also provides reference information for the MedML 
elements and scripting objects that are used to import and export data 
to and from the InForm application, as well as sample data import 
XML. 

This document is also available from the Documentation CD. 

MedML Installer utility 
online Help 

The MedML Installer utility online Help provides information about, 
and step-by-step instructions for using, the MedML Installer utility, 
which is used to load XML that defines study components into the 
InForm database. 

This guide also provides reference information for the MedML 
elements and scripting objects that are used to import and export data 
to and from the InForm application, as well as sample data import 
XML. 

This document is also available from the user interface. 
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Document Description 

InForm Data Export 
utility online Help 

The InForm Data Export utility online Help provides information 
about and step-by-step instructions for using the InForm Data Export 
utility, which is used to export data from the InForm application to the 
following output formats: 

• Customer-defined database (CDD). 

• Name value pairs. 

This document is also available from the user interface. 

InForm Data Import 
utility online Help 

The InForm Data Import utility online Help provides information 
about and step-by-step instructions for using the InForm Data Import 
utility, which is used to import data into the InForm application. 

This document is also available from the user interface. 
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If you need assistance 
Oracle customers have access to support through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info, or if you are hearing impaired, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs. 
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InForm 6.0 product image 
The InForm product image includes folders that contain: 

• Native installers—The native installer folder contains setup files that install the base products 
necessary for the InForm software and the InForm Portal software to run. 

• Customization wizards—The customization wizard folders contain setup files you use to apply 
customizations needed for an installation of the Reporting and Analysis module. Use the 
customization wizard folders only if you are installing the Reporting and Analysis module. 

 

Folder Description 
InForm Contains the InForm core and the InForm Portal installation software. 

CRNConfig Contains files used to run the Cognos Customization for InForm wizard.  

CRNGatewayConfig Contains files used to run the Cognos Gateway Customization for InForm 
wizard.  
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InForm software components 

Overview of the InForm system architecture 
The InForm software is a four-tiered software design. The following illustration is a logical 
representation of the system architecture. 

 

 
 

Tier Software component 
hosted on the tier 

Description 

Client Web browser Displays the pages of a study and receives user input. 

Note: Cognos 8.4.1 does not support Internet 
Explorer 9.0, Google Chrome, or Apple Safari. 

Web Web server and gateway 
software (MS-IIS) 

Services requests to and from the web browser. 

 Cognos 8 BI Gateway Manages the transfer of information from the Web 
server to another server. Provides secure access to the 
Cognos 8 Business Intelligence (Cognos 8 BI) Server. 



Chapter 1  Preparing to install  
 

6 InForm 6.0 

Tier Software component 
hosted on the tier 

Description 

Client Web browser Displays the pages of a study and receives user input. 

Note: Cognos 8.4.1 does not support Internet 
Explorer 9.0, Google Chrome, or Apple Safari. 

Application InForm application server Logical server that acts as a transaction manager for 
InForm studies under the InForm Service. The 
InForm Server handles caching and Microsoft 
Transaction Server (MTS) packages. Each study is 
associated with an InForm study application server. 

 Cognos 8 BI Reporting 
server 

Runs reporting-related requests for operating system 
services. There is one Cognos 8 BI Service per 
physical server machine. 

 Cognos Content Manager Manages the storage of customer application data, 
including security, configuration data, models, 
metrics, report specifications, and report output. 
Content Manager is needed to publish packages, 
retrieve or store report specifications, manage 
scheduling information, and manage the Cognos 
namespace 

 Oracle Directory Server Provides secure Admin access to the InForm 
Reporting database. 

Data Oracle database instances 
for: 

• InForm database—Stores the study components 
and the clinical data. Studies typically share an 
instance of the Oracle database with the InForm 
Admin schema. 

• InForm Admin database—Used by the InForm 
Service to manage all the studies on a physical 
machine. There is one InForm Admin database 
per InForm Service. 

• InForm Reporting database—Stores views for 
Cognos Reporting through the Reporting and 
Analysis module. The InForm Reporting database 
can share an instance of the Oracle database with 
the InForm Admin and study databases or can 
reside in a separate Oracle database instance. In 
an installation in which Cognos Reporting is 
enabled, each InForm study database has a 
corresponding InForm Reporting database. 

• Cognos 8 BI Content Store—Stores user-created 
reporting objects such as folders, saved reports, 
and saved views. The Content Store usually 
resides in a separate Oracle database instance. 
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About the Cognos Private Gateway 
If you install the Reporting and Analysis module, you must also install a Private Gateway. The Private 
Gateway provides secure access to certain Cognos 8 Business Intelligence software administrative 
tasks that are not available through the InForm user interface.  

The Private Gateway must be located on a secure, dedicated server (the Cognos Private Gateway 
Server) that is accessible to a limited number of users with administrative privileges for the Cognos 8 
Business Intelligence software. For more information, see Prepare the Cognos Gateway Server (on 
page 80). 
 

Application server options 
You can distribute the software components across multiple application servers to best fit your 
environment. You can use one of the following deployment options: 

• Minimal server deployment—Install the InForm software and the Reporting and Analysis 
module on the fewest possible number of servers. 

• Multiple server deployment—Install the InForm software and the Reporting and Analysis 
module on multiple servers. 

• Distributed deployment—Install the InForm software and the Reporting and Analysis module 
on separate servers. 

 

Minimal server deployment 
A minimal-server deployment requires four servers: 

• InForm Application Server 

• A server that hosts the Cognos components and the Oracle Directory Server: 

• Report application 

• Content Manager 

• Gateway 

• Oracle Directory Server 

• Private Gateway 

• A server for all the database instances. 
 



Chapter 1  Preparing to install  
 

8 InForm 6.0 

Multiple server deployment 
In a multiple server deployment, the InForm Server, the Cognos 8 Business Intelligence Server, and 
the study and reporting databases are on at least six separate server machines that conform to 
InForm hardware and software requirements.  

For example, a multiple server deployment might include eight server machines configured as 
follows: 

• One Cognos Gateway Server machine. 

• One Cognos Private Gateway Server machine. 

• One Cognos server machine containing the: 

• Cognos Report server. 

• Cognos Content Manager server. 

• One InForm Application server machine. 

• One Oracle Directory Server machine. 

• Three dedicated Oracle database server machines: 

• InForm study. 

• InForm Reporting. 

• Cognos 8 BI Content Store. 

Note: The InForm application server(s) and the Cognos 8 BI application server(s) must be in the 
same domain.  
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Distributed server deployment 
In a distributed server deployment, the InForm Application Server, the Cognos Report Server, the 
Cognos Content Manager Server, the Cognos Gateway Server, the Oracle Directory Server, and the 
study and reporting databases are on separate server machines that conform to InForm hardware and 
software requirements.  

For example, a distributed server deployment might include at least nine server machines configured 
as follows: 

• One InForm Application server machine. 

• One Cognos Gateway Server. 

• One Cognos Private Gateway Server 

• One Cognos Report Application Server. 

• One Cognos Content Manager Server. 

• One Oracle Directory Server machine. 

• Three dedicated Oracle database server machines: 

• InForm database instance. 

• InForm reporting database instance. 

• Cognos 8 BI Content Store database instance. 
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Database configuration options 
You can use different configurations for your database instances when you install the InForm 
software. You can choose: 

• SameDB—The InForm database and the InForm reporting database are installed on a single 
database instance. 

• DiffDB—The InForm database and the InForm reporting database are installed on separate 
database instances. 

• Distributed deployment—The database instances are configured to distribute tablespaces 
across multiple database servers. For more information, see Multiple study tablespaces (on 
page 35). 

 

SameDB—Single database instance for InForm and Cognos reporting 
software 

For the default configuration, Oracle recommends installing the InForm software and the Reporting 
and Analysis module in the same database instance, and installing in different database instances only 
in certain cases.  

• You can install in the same database instance if your study has up to 70 concurrent users and 8 
concurrent reporting connections. The 8 reporting connections can be any combination of 
running an ad hoc query, a standard or custom report, or a report job. 

• If your study requires more than 70 concurrent users and 8 concurrent reporting connections, 
installing in the same database instance may still be acceptable. However, you may want to 
consider installing the InForm software and the Reporting and Analysis module in different 
database instances. 

• If your study requires 16 or more concurrent reporting connections, Oracle recommends 
installing in different database instances. 

Observe the following architecture rules when setting up a single database instance for the InForm 
software and the Reporting and Analysis module: 

• Only one reporting environment is allowed per study schema. 

• A single database can hold multiple reporting schemas. 

• The study and reporting schema cannot be installed in the same database as the Content Store 
database for Cognos 8 Business Intelligence. No other Oracle products, such as the CIS software 
or the Clintrial software, should already reside in or be added to the study and reporting 
database. 

• The InForm study and reporting database is not required to run in archive log mode. 
 



 Installation Guide  

InForm 6.0 11 

DiffDB—Separate database instances for InForm and Cognos reporting 
software 

If you choose to install the InForm and Cognos reporting software on separate database instances, 
you could use separate database instances for each of the following: 

• Each InForm server, which contains one InForm Admin schema and multiple InForm study 
schemas. 

• InForm Reporting schema. 

• Cognos 8 BI Content Store schema. 

• PFCap Admin schema 

Note: The PFCap Admin schema can reside in a separate instance or the same instance as 
the Cognos 8 BI Content Store schema. 

Observe the following architecture rules: 

• You must install the Reporting and Analysis environment (InForm Reporting database) in a 
different database instance than the instance for the study. 

• The InForm application server(s) and the Cognos 8 BI application server(s) must be in the same 
domain.  

• The Oracle user name for the reporting schema in the reporting database instance must be the 
same as the Oracle user name for the study schema in the study database instance. Because the 
users are in different database instances, the user names may have different passwords. 

• Only one reporting environment is allowed per study schema. 

• A single reporting database can hold multiple reporting schemas. The study schemas that are 
associated with these reporting schemas might exist in one or in multiple study databases. 

• The study and reporting schemas cannot be installed in the same database as the Content Store 
database for Cognos 8 Business Intelligence. No other Oracle products, such as the CIS software 
or the Clintrial software, should already reside in or be added to the study and reporting 
database. 

• The study schema must be created with archive log mode enabled. 

For more information, see Archive log mode in a multiple database environment (on page 
30). 

 

Distributed deployment options 
You can distribute your study and reporting databases across multiple disk partitions on the same 
server or multiple database servers. For more information, see Multiple study tablespaces (on page 
35). 

Note: SameDB and DiffDB databases can be deployed in a distributed environment. 
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Externally hosted studies 
Externally hosted studies must conform to the following requirements, or authentication issues will 
result. 

• The InForm application server(s) and the Cognos 8 BI application server(s) must be in the same 
domain. 

• You must use the fully qualified domain name to access the site. 
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Determining resources for multiple studies 
You can install one or more studies on an InForm application server or on a physical server. When 
deciding the load that you will place on a server, consider: 

• The number of InForm application servers on each physical server machine. 

• The number of studies on each InForm application server. 

Note: Oracle recommends installing only one study per InForm application server in a 
production environment. 

• The size of the intended InForm application server (each server requires 40 to 50 megabytes of 
memory). 

• The number of studies you intend to run on the server machine. 

• The system availability requirements. 

• The geographic proximity of sites to the server. 
 

Guidelines for determining resources 
Follow these basic guidelines for determining resources: 

• Use separate server machines for production studies and studies that are used for testing and 
training. 

• Consider using one server machine for multiple smaller studies (especially Phase 1 studies) that 
are on separate InForm application servers. 

• Use a separate server machine for each large study (especially Phase 3 studies). Although multiple 
servers might require additional resources and additional cost, they also provide increased 
dependability and stability.  

Separate server machines can reduce risk. If you have more than one study on a server machine 
and make an error in setup or configuration, all the studies on that server are affected. 
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Sizing the server 
When sizing an InForm application server, be aware of the resources that are already being used. 
Make sure that you monitor the servers during the studies. When sizing your server, consider the 
average number of: 

• Sites. 

• Subjects per site. 

• CRFs (forms). 

• Data items. 

• Users. 

For each study, consider the following: 

• Good Clinical Practice (GCP) status of the study (GCP or non-GCP). 

• Study phase. 

• Study duration. 

• Enrollment rate. 

• Geographic proximity of servers to sites. 

• System availability requirements. 

• Number of sites. 

• Number of users. 

• Number of subjects. 

• Number of unique forms. 

• Maximum number of items per form. 

• Average number of items per form. 

• Maximum number of rules per form. 

• Average number of rules per form. 

• Total number of forms per subject. 
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Configuring client computers 

Browser settings for Internet Explorer 
Configure the following Internet Explorer settings to access the InForm application and the 
Reporting and Analysis module. 

Internet Explorer 9.0 is not supported for the Reporting and Analysis module. 

• Specify the preferred browser language. 

• To view reports in Microsoft Excel format: 

• Set the InForm web site domain and the Reporting and Analysis web site domain as trusted 
sites. 

• Enable automatic prompting for file downloads. 

• Enable notifications when downloads complete. 

• Configure pop-up blocking to allow pop-ups for the InForm web site domain and the Reporting 
and Analysis web site domain. 

• Prevent automatic password completion. 

• Specify that you want to save encrypted files to disk. 

• Automatically check for newer versions of stored pages. 

• Set the amount of disk space to use to 6 MB. 

• Set the HTTP and SSL options to use HTTP 1.1 and SSL 3.0. 

• Enable printing background colors and images for graphics. 

• Modifying security settings: 

• Allow META REFRESH. 

• Enable active scripting. 

• Set up tabbed browsing to launch links in a new tab. 

For more information, see the Internet Explorer online Help. 
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Browser settings for Apple Safari 
Configure the following Apple Safari settings to access the InForm application. 

Apple Safari is not supported for the Reporting and Analysis module. 

• Specify the preferred browser language. 

• Configure pop-up blocking to allow pop-ups for the InForm application web server. 

• Prevent Safari from using automatic password completion. 

• Modify security settings to accept cookies. 

• Set up tabbed browsing to launch links in a new tab. 

For more information, see the Apple Safari online Help. 
 

Browser settings for Firefox 
Configure the following Firefox settings to access the InForm application and the Reporting and 
Analysis module. 

• Specify the preferred browser language. 

• Configure pop-up blocking to allow pop-ups for the InForm web site domain and the Reporting 
and Analysis web site domain. 

• Prevent Firefox from using stored passwords. 

• Set the SSL option to use SSL 3.0. 

• Modify security settings to accept cookies. 

• Set up tabbed browsing to launch links in a new tab. 

For more information, see the Firefox online Help. 
 

Browser settings for Google Chrome 
Configure the following Google Chrome settings to access the InForm application. 

Google Chrome is not supported for the Reporting and Analysis module. 

• Specify the preferred browser language. 

• Configure pop-up blocking to allow pop-ups for the InForm web site domain and the Reporting 
and Analysis web site domain. 

• Prevent Chrome from using stored passwords. 

• Set the SSL option to use SSL 3.0. 

• Modify security settings to accept cookies. 

• Set up tabbed browsing to launch links in a new tab. 

For more information, see the Chrome online Help. 
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Windows Explorer settings 
Configure the following Windows Explorer settings to access the InForm application and the 
Reporting and Analysis module. 

• Make sure the files with the XLS and XLSX extensions are not set to Browse in the same 
window. 

• Associate files with the XLS and XLSX extensions with the Microsoft Excel spreadsheet 
software. 
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Performance Options setting in System Properties 
If the InForm application server is also the database server for the study database instance, you might 
receive errors that are related to cache initialization time when installing a study if the system setting 
for Processor scheduling is not set to Adjust for best performance of Programs. 

1 On the InForm application and database server, open the System Properties dialog box, and 
select Advanced. 

2 In the Performance section, click Settings. 

The Performance Options dialog box appears. 

3 Click Advanced. 

4 In the Processor scheduling section, click Programs. 

5 Click OK in both dialog boxes. 

Note: When the InForm application server and database server are different machines, the 
system setting for Processor scheduling in the System Properties > Performance Options dialog 
box should be the default value, Background services. 
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About installing the Oracle database software 
To install the Oracle database software, refer to your Oracle database documentation. 

To ensure a successful installation, make sure your environment is set up correctly. For hardware and 
software requirements, see the Release Notes. 
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Install the Oracle database software—SameDB 
If you plan to use a SameDB configuration, you must install the Oracle database software on the: 

• InForm database server. 

• Cognos Content Store database server. 

For more information on the SameDB configuration, see: 

• Steps to create database instances—SameDB (on page 25). 

• Steps to create database users—SameDB and DiffDB (on page 31). 
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Install the Oracle database software—DiffDB 
If you plan to use a DiffDB configuration, you must install the Oracle database software on the: 

• InForm database server. 

• InForm Reporting database server. 

• Cognos Content Store database server. 

For more information on the DiffDB configuration, see: 

• Steps to create database instances—DiffDB (on page 25). 

• Steps to create database users—SameDB and DiffDB (on page 31). 
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About configuring the Oracle database software 
To configure the Oracle database, you must create the: 

• Database instances and tablespaces 

For more information, see Create Oracle Database instances (on page 26). 

• Database users 

For more information, see Create database users (on page 31). 
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Create database instances 

Steps to create database instances—SameDB 
If you are using a SameDB configuration, you must: 

1 Create instances on the: 

• InForm database server. 

• Cognos Content Store database server. 

For more information, see: 

• Create Oracle Database instances (on page 26) 

• Creating a database instance for the Cognos 8 BI content store (on page 27) 

2 Set the initialization parameters for the database instances on the InForm database server. 

For more information, see Set the initialization parameters for the database instances (on 
page 27). 

 

Steps to create database instances—DiffDB 
If you are using a DiffDB configuration, you must: 

1 Create instances on the: 

• InForm database server. 

• InForm Reporting database server. 

• Cognos Content Store database server. 

For more information, see: 

• Create Oracle Database instances (on page 26). 

• Creating a database instance for the Cognos 8 BI content store (on page 27). 

2 Set the initialization parameters for the database instances on the InForm, Reporting, and 
Content Store database servers. 

For more information, see: 

• Set the initialization parameters for the database instances (on page 27). 

• Study database parameters—Different database instances (on page 29). 

• Archive log mode in a multiple database environment (on page 30). 
 



Chapter 3  Configuring the Oracle database software  
 

26 InForm 6.0 

Create Oracle Database instances 
Use the Oracle tools to create the instances required for your configuration. 

Use the following character set specifications for the InForm, Reporting, and Content Store 
instances: 

• Database Character Set—AL32UTF8. 

• National Character Set—AL16UTF16. 

To verify the character set settings: 

1 Log into SQL*Plus and type: 

sqlplus <system_userid>@<connection_string> 

When prompted, enter the system user password. 

2 Run the following command: 

select * from nls_database_parameters 
where parameter = 
any('NLS_CHARACTERSET','NLS_NCHAR_CHARACTERSET'); 

 

Create the InForm database instance 
1 Set up an Oracle database instance.  

2 Populate the database instance for the InForm database server with the following tablespaces: 

• SYSAUX 

• SYSTEM 

• UNDOTBS1 

• USERS 

• TEMP 

• TEMPBIG 

• TRIAL_INDEX_TS 

• TRIAL_TABLE_TS 

• INFORM 

• INFORM_LOB 

3 Update the tnsnames.ora file located on the InForm Application Server to contain an alias 
establishing a connection to the database server. 
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Create the reporting database instance 
1 Set up an Oracle database instance.  

2 For a SameDB environment—The reporting database uses the InForm database instance. 

For a DiffDB environment—The reporting database instance on the Reporting database server 
with the same tablespace names used for the study database. 

3 Update the tnsnames.ora file to contain an alias establishing a connection to the database server. 

• For a SameDB environment, the tnsnames.ora file is located on the InForm Application 
Server. 

• For a DiffDB environment, the tnsnames.ora file is located on the Cognos Report Server. 
 

Creating a database instance for the Cognos 8 BI content store 
• Set up an Oracle database instance on the Content Store database server.  
 

Set the initialization parameters for the database instances 
Depending on your environment, you might need one, two, or three database instances (the study, 
the Reporting and Analysis module, and Cognos 8 BI can each use an instance). 

When creating each InForm Oracle Instance, use the following initialization parameters in the 
Init.ora file. 

Note: Additional parameter settings are required if your installation includes Cognos 8 BI and the 
Reporting and Analysis module in a DiffDB environment (your study and reporting databases are 
in separate database instances). For more information, see Study database parameters—
Different database instances (on page 29). 

 

Parameter Production server values Development server values 

memory_target Average trial: 1500 MB 
Large trial: 10 GB 
Mega trial: 25 GB 

Up to 80% of memory 
available to the Oracle 
database 

cursor_sharing exact exact 

db_block_size 16384 16384 

db_file_multiblock_read_count 16 16 

db_cache_size 

See Note 1. 

0 0 

db_files Database dependent. Database dependent. 

open_cursors 

See Note 1. 

150 150 
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Parameter Production server values Development server values 

processes 

See Note 1. 

150 (or maximum number of 
concurrent processes) 

50 

session_cached_cursors 150 150 

shared_pool_reserved_size 5M 3.5M 

streams_pool_size 200M 200M 

job_queue_processes 5 minimum: 1 job for each 
study (the job to update 
PF_HEARTBEAT table every 
minute in each study schema) 
and 1 job for each propagation, 
plus streams’ minimum 
requirement of 2 and Oracle 
MTS’s requirement of 1)  

5 minimum: 1 job for each 
study (the job to update 
PF_HEARTBEAT table every 
minute in each study schema) 
and 1 job for each 
propagation, plus streams’ 
minimum requirement of 2 
and Oracle MTS’s 
requirement of 1)  

statistics_level Typical Typical 

workarea_size_policy auto auto 

_optimizer_cost_based_transform
ation 

See Note 2. 

Off Off 

sec_case_sensitive_logon False False 

_push_join_predicate False False 

deferred_segment_creation (11g 
only) 

False False 

skip_unusable_indexes True. True. 

undo_retention 900 900 

parallel_max_servers 3 3 
 

Note 1: These parameters might need to be adjusted depending on the demands on the 
database that are created by the InForm application and Streams. 

Note 2: Workaround provided by Oracle for database issue 5382842. 
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Study database parameters—Different database instances 
In a DiffDB environment, the Reporting and Analysis module requires you to add or modify several 
study database parameters. The following table shows the adjustments that must be made to these 
parameters. All settings are necessary for both production and development servers. 

Additionally, it is recommended that you review the processes and sessions parameters, which are 
not mandatory for the Reporting and Analysis installation. 

For more information, see the Oracle database document, Oracle Streams Recommendations. 
 

Parameter Value Comments 
AQ_TM_PROCESS 1 Must be set on both the study database and the 

reporting database (streams processing might 
hang if set to 0). 

global_names TRUE  

job_queue_processes 5 minimum 5 minimum: 1 job for each study (the job to 
update PF_HEARTBEAT table every minute in 
each study schema) and 1 job for each 
propagation, plus streams’ minimum requirement 
of 2 and Oracle MTS’s requirement of 1)  

log_archive_dest Destination where 
the archive logs 
will be written 

You must enter at least one destination. 

log_archive_dest_state_1 ENABLE This enables the archive log destination 
(log_archive_dest_1). You must enter a state for 
every destination. 

open_links Four minimum Four minimum is recommended by Oracle for 
Streams. 

parallel_max_servers 10 Minimum: 3 dependent on the number of parallel 
apply and/or capture processes. 

timed_statistics TRUE Recommended by Oracle for collecting elapsed 
time information for Streams. 

undo_retention 900 (minimum 
value) 

 

_job_queue_interval One Recommended by Oracle for Streams. 

deferred_segment_creation 
(11g only) 

False  

 
 



Chapter 3  Configuring the Oracle database software  
 

30 InForm 6.0 

Archive log mode in a multiple database environment 
If you are using a DiffDB configuration, you must create the study database with archive log mode 
enabled. You can create the database with scripts or with the Oracle Database Configuration 
Assistant utility. 

• Scripts—Specify archivelog as part of the create database statement. 

• Oracle Database Configuration Assistant—On the Archive tab, select the Archive Log 
Mode checkbox during the Initialization Parameters step. 

Note: For more information about the Oracle Database Configuration Assistance utility, see 
the Oracle database document, Oracle Administrators Guide for your platform. 
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Create database users 

Steps to create database users—SameDB and DiffDB 
If you are using a SameDB or DiffDB configuration, you must: 

1 Create the InForm database users on the InForm database server. 

For more information, see: 

• Required InForm database accounts (on page 32). 

2 Create the Cognos PFCapAdmin and the Content database users on the Cognos Content Store 
database server. 

For more information, see: 

• Create a user for the Cognos 8 BI content store database (on page 33). 

• Create the PFCapAdmin user on the Content Store database server (on page 34). 

3 If you are using a DiffDB configuration you must also create the rptinstall user on the Reporting 
database server. 

For more information, see Create the rptinstall user on the InForm database server and the 
Reporting database server for DiffDB (on page 33). 
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Required InForm database accounts 
The following database accounts are required for each instance of the InForm Service: 

• A DBA user for the InForm software. The default name of this user is pfdbadmin. 

• A user that can connect to the InForm Admin database. The default name of this user is 
informadmin. 

The recommended way to create these accounts is to select the options to create them in the InForm 
installation wizard. If you need to create either account at another time, you can run a script. 

 

Default account 
name 

Installation wizard checkbox Script and where to get information 

pfdbadmin Prep Oracle 

For more information, see Step 2: 
Install the InForm core software 
on the InForm Application Server 
(on page 50). 

informprepora.vbs (on page 138) 

For more information, see the Study and 
Reporting Setup Guide. 

informadmin Install Admin DB 

For more information, see Step 2: 
Install the InForm core software 
on the InForm Application Server 
(on page 50). 

admindb (on page 130) 

For more information, see the Study and 
Reporting Setup Guide. 

 

In a multiple server installation of the InForm software, you create the pfdbadmin and informadmin 
accounts on each server where you install the InForm software. 

Note: You need to create the pfadmin user only one time per database instance. Therefore, if you 
uninstall and reinstall the InForm software in the same database instance, you can leave the 
Prep Oracle checkbox deselected during the second installation. 
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Create a user for the Cognos 8 BI content store database 
1 Verify that the character set for the content store database is Unicode. 

2 Create a user and grant the user these roles and privileges: 

• Roles 

• CONNECT 

• RESOURCE 

• Privileges 

• CREATE ANY VIEW 

• UNLIMITED TABLESPACE 

3 Validate the database connection from the Cognos 8 BI server by typing: 

sqlplus <contentuser_userid>@<tnsnames_alias> 

At the prompt, enter the content user password. 

If the test is successful, a SQL prompt appears, showing that you have logged on to the database 
server as the content store database user. An unsuccessful test generates an ORA- error. Consult 
your database administrator for help in troubleshooting errors. 

 

Create the rptinstall user on the InForm database server and the Reporting 
database server for DiffDB 

1 Open a Command Prompt window. 

2 Log on to the study database with a user that has sysdba privileges. Make sure that the 
connection is made with the as sysdba clause. 

3 Run this command: 
create user rptinstall identified by <dbauser_study_password> default 
tablespace <tablespace_name> temporary tablespace <tablespace_name> 

 
<dbauser_study_password>—The password for rptinstall, the database user for the study. This 
password is case-sensitive. 

<tablespace_name>—A valid tablespace name in the database. Oracle recommends that you do 
not use the SYSTEM tablespace for the default tablespace. 

Note: The default tablespace does not require additional room for objects, because the 
rptinstall user does not own objects. 

4 Type the following at the SQL*Plus prompt: 
@grant_dba_privs rptinstall 
 

The grant_dba_privs.sql script is located in the <Installation_Directory>\InForm\bin\DBOra 
folder. 

For more information, see grant_dba_privs.sql (on page 136). 
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Create the PFCapAdmin user on the Content Store database server 
1 Create the user PFCapAdmin on the Content Store database server and grant the user these roles 

and privileges: 

• Roles 

• CONNECT 

• RESOURCE 

2 Run the create_cap_table.sql script (located in the <Installation_Directory>\InForm\bin\DBOra 
folder) to create a table called TRIAL_URLS within this user/schema. 

For more information, see create_cap_table.sql (on page 133). 

Note: The CAP schema can reside in the content store database instance or a separate 
database instance. 

3 Validate the database connection from the Cognos 8 BI server by typing: 

sqlplus <contentuser_userid>@<connection_string> 

When prompted, enter the content user password. 

If the test is successful, a SQL prompt appears, showing that you have logged on to the database 
server as the PFCapAdmin user. An unsuccessful test generates an ORA- error. Consult your 
database administrator for help in troubleshooting errors. 
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Multiple study tablespaces 
By default, all study objects are created in the INFORM tablespace. In a production environment, 
you should distribute each study across multiple tablespaces for improved performance and for 
maintenance and monitoring. Before you install your study on a production server, set up the study-
specific tablespaces. 

The following table lists the Oracle table and index tablespaces to create, along with the required 
parameters. All tablespaces should be locally managed.  

Note: When creating the study tablespaces, use the names listed in the following table. 

 

Table tablespace Index tablespace Size (MB) 
%STUDY_NAME%_REF %STUDY_NAME%_REF_IDX 120 

%STUDY_NAME%_HIGH_TXN1 %STUDY_NAME%_HIGH_TXN1_IDX 300 

%STUDY_NAME%_HIGH_TXN2 %STUDY_NAME%_HIGH_TXN2_IDX 500 

%STUDY_NAME%_HIGH_TXN3 %STUDY_NAME%_HIGH_TXN3_DX 600 

%STUDY_NAME%_HIGH_TXN4 %STUDY_NAME%_HIGH_TXN4_IDX 500 

%STUDY_NAME%_TXN %STUDY_NAME%_TXN_IDX 250 
 

The remaining syntax for each of these tablespaces is: 

AUTOEXTEND ON NEXT 50M 
EXTENT MANAGEMENT LOCAL AUTOALLOCATE; 
 

Note: The STUDY_NAME portion of the tablespace name must conform to Oracle database name 
standards. It cannot start with a numeric character and cannot contain special characters. 
Additionally, because the Oracle database has an internal limit of 30 characters for a tablespace 
name, the study name must be 16 characters or fewer. 

Oracle provides sample configurations for distributing your tablespaces using from one to five disks. 
 

Distributed InForm study tablespaces 
In a production environment, Oracle recommends distributing tablespaces across multiple disks. 
This table presents a suggested model. In each configuration, it is recommended that you use the C: 
partition for the operating system and distribute the database and application components across the 
remaining partitions. Monitor your system to determine the optimal configuration. 

• C: and D: are partitions on one disk. 

• INFORM, SYSTEM, TEMPBIG are tablespaces. 

Note: TEMPBIG is a temp tablespace and the default temporary storage location for the 
InForm application. 
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Physical disks 0 1 2 3 4 

Logical disks C: D: E: F: G: H: 
1 disk Windows 

2008 
Oracle 
INFORM 
SYSTEM 
Study Tables 
Study 
Indexes 
TEMPBIG 
Redo logs 
UNDOTBS 
Archive logs 

    

2 disks Windows 
2008 

Oracle 
INFORM 
SYSTEM 
Study Tables 
Redo logs 

Study 
Indexes 
TEMPBIG 
Redo logs 
UNDOTBS 
Archive logs 

   

3 disks Windows 
2008 

Oracle 
INFORM 
SYSTEM 
Redo logs 

Study 
Indexes 
TEMPBIG 
Redo logs 
UNDOTBS 
Archive logs 

Study 
Tables 

 

  

4 disks Windows 
2008 

Oracle 
INFORM 
SYSTEM 
Redo logs 

TEMPBIG 
Redo logs 
UNDOTBS 
Archive logs 

Study 
Tables 

 

Study 
Indexes 

 

 

5 disks Windows 
2008 

Oracle 
SYSTEM 
Redo logs 

INFORM 
Redo logs 
UNDOTBS 

 

Study 
Tables 

 

Study 
Indexes 

 

TEMPBIG 
Archive logs 

 

Note: For a Linux database server, the disk and partition names would follow the naming 
conventions for those environments. 

 



 Installation Guide  

InForm 6.0 37 

Creating the INFORM_LOB tablespace 
The INFORM_LOB tablespace is optional for InForm installation. To create the INFORM_LOB 
tablespace, use the following syntax: 

CREATE TABLESPACE INFORM_LOB 
DATAFILE ‘<path_to_data_file>’ SIZE <initial_size> 
AUTOEXTEND ON NEXT 
EXTENT MANAGEMENT LOCAL AUTOALLOCATE; 

 

Tablespace name Initial size/ 
autoextend size 
needed 

File extent size/file 
maximum size 

Comments 

INFORM_LOB 200M Make the initial size 
200 megabytes, set 
AUTOEXTEND on 
and set MAXSIZE to 
UNLIMITED. 

Use of this tablespace is optional, 
but, if used, the name 
INFORM_LOB is required for 
this tablespace. This tablespace 
can be used to hold large objects. 
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Set up Oracle XA Transaction Support 
To set up the Oracle database to support MTS transactional components, enable Oracle XA 
Transaction Support. You must enable Oracle XA Transaction Support for both development and 
production environments.  

1 Select the Prep Oracle checkbox during the InForm installation. For more information, see 
Step 2: Install the InForm core software on the InForm Application Server (on page 50). 

or 

Run the mtsora102.vbs script during or after the Oracle installation. 

You must run the mtsora102.vbs script only if you are manually setting up XA Transaction 
Support. 

For more information, see mtsora102.vbs (on page 141). 

Note: In a multi-tier environment, select the Prep Oracle checkbox during the InForm 
installation on each InForm application server, and run the mtsora102.vbs script on each 
InForm database server. Restart the server if the script changes any of the MSDTC\Security 
or MSDTC\XADLL registry keys. 

2 Run the oramtsadmin.sql command from the ...\oramts\admin folder of the Oracle Client 
home (where Oracle Services for Microsoft Transaction Server was installed).  

You must run it as the SYS user with the SYSDBA role. Run the script against all Oracle 
instances connected to the InForm Application Server. 

For more information, see oramtsadmin.sql (on page 143). 
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Steps to install and configure the Oracle database client 
1 Install the Oracle database client on the: 

• InForm Application Server 

• Cognos Content Manager Server 

• Cognos Report Server 

For more information, see your Oracle database documentation. 

2 Update the registry settings on each server where you installed the Oracle database client. 

For more information, see Update the National Language Support registry settings on the 
Oracle database client (on page 41). 

3 Configure the database connection. 

For more information, see Configure the database connection (on page 42). 

4 Validate the database connection. 

For more information, see Validate the database connection (on page 43). 
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Update the National Language Support registry settings on 
the Oracle database client 

The following registry settings are required for the Oracle client home on the InForm Application 
Server, the Cognos Report Server, and the Cognos Content Manager Server.  

The entries are in the following Windows Registry key:  

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\<Oracle_client_home_key> 
 

Option Value 
NLS_LANG American_America.AL32UTF8 

NLS_SORT JAPANESE_M 
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Configure the database connection 
To configure the Oracle client on the InForm Application Server, the Cognos Report Server, and the 
Cognos Content Manager Server to connect with the database server: 

• Update the tnsnames.ora file located on the application server so that it contains the alias that is 
used to establish a connection to the database server.  

Note: When installing the InForm software, you enter the alias specified in the tnsnames.ora file 
as the database connect string. 
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Validate the database connection 
To validate the database connection from the InForm Application Server, the Cognos Report Server, 
and the Cognos Content Manager Server 

• Type the following command at the Windows command prompt: 

sqlplus pfdbadmin_userID@tnsnames_alias 

When prompted, enter the pfdbadmin password. 

The default user name for the pfdbadmin database account is pfdbadmin.  

If the test is successful, a SQL prompt appears, showing that you have logged on to the database 
server as the pfdbadmin user. An unsuccessful test generates an ORA- error. Consult your database 
administrator for help in troubleshooting errors. 

Note: Problems with connections can sometimes be attributed to the database server that 
contains a single Ethernet card with two nodes. Disabling one of the ports from the card usually 
solves the problem. Consult your system administrator for help in resolving errors. 
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Steps to prepare the InForm Application Server 
All InForm installations use an InForm Application Server. 

To prepare the InForm Application Server: 

1 Verify the Oracle database client. 

For more information, see Steps to install and configure the Oracle database client (on page 
40). 

2 Install the InForm core software. 

For more information, see Step 2: Install the InForm core software on the InForm 
Application Server (on page 50). 

3 Update the DomainSuffix entry for the AuthenticationFilter registry key. 

For more information, see Step 3: Update the DomainSuffix entry for the 
AuthenticationFilter registry key on the InForm Application Server—Optional (on page 
56). 

If you are using Reporting, you must also update the DomainSuffix entry on the Cognos 
Gateway Server. For more information, see Step 4: Update the DomainSuffix entry for the 
AuthenticationFilter registry key on the Cognos Gateway Server—Public Gateway only 
(on page 85). 

4 Enable SSL—Optional. 

For more information, see About enabling Secure Sockets Layer (SSL) (on page 104). 

5 Qualify the installation. 

For more information, see Qualify the installation (on page 58). 
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Step 1: Verify the Oracle database client on the InForm 
Application Server 

Before you begin, ensure that you have followed the instructions in Installing and configuring the 
Oracle database client (on page 39) to make sure the following requirements are met on the 
InForm Application Server: 

• The Oracle database client is installed. 

• The language registry settings are updated. 

• The database connection is configured and verified. 
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Step 2: Install the InForm core software on the InForm 
Application Server 

You install the InForm core software on InForm Application Server only. 

1 Download and extract the InForm software from the Oracle Download Center. 

2 Navigate to the location of the installation files on the downloaded image, and double-click 
setup.exe.  

The Choose Setup Language page appears.  

3 Select either English or Japanese for the language that you want the wizard to use during the 
installation. 

Note: Configuration of the language used for application pages occurs later in the 
installation. 

4 Click Next.  

The Preparing Setup progress page appears. When setup is complete, the Welcome page appears.  

5 Click Next. 

The Customer Information page appears.  

6 Type your User Name and Company Name.  

7 Click Next. 

The Choose Destination Location page appears.  

8 Accept the default location, or click Change and browse to the desired location.  

9 Click Next. 

The Setup Type page appears. 

10 Choose one of the following options, and click Next. 

• Complete—Installs all the application components (Default). 

• Minimal—Installs only the required application components and the MedML Installer utility. 
The InForm Portal, sample study, and other utilities are not installed. 

• Custom—Allows you to select the components to install. 
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If you select Complete or Minimal, the Select Product Locale page appears.  

If you select Custom, the Select Features page appears. Make your choices and click Next. 
 

 
 

11 Select either English or Japanese for the Product Locale for the installation.  

This determines the language in which the InForm application pages appear after installation. 

12 Click Next. 

The Select the Authentication Scheme page appears. 

13 Select Native Authentication. 

14 Click Next. 
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The Select the Oracle Home for InForm page appears. The Oracle Homes you configured 
during your Oracle installation appear on the page with the prefix KEY_ to indicate the 
Windows registry key. 

 

 
 

15 Select the entry for the Client Oracle Home registry key.  

16 Click Next. 

The Database Configuration page appears. 

Note: The defaults on this page were set when you configured the Oracle database. The 
values for your installation might be different. When installing onto a production server, 
Oracle recommends that you change the pfdbadmin password after running this wizard. For 
guidelines on choosing a password, see the Secure Configuration Guide. 
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17 Enter values or accept the defaults for the configuration fields, and click Next. 

If any of the information is incorrect (for example, the Database Connection String or InForm 
Username is wrong), a Database Configuration Error window appears. For more information, 
see Oracle MTS configuration is invalid (on page 164). 

 

Field Description 
Local Machine User The name of the local machine user. The default is 

pfUSR_<machinename>. 

Local Machine User 
Password 

The password for the local machine user. 

Note: The password for the local machine user must comply with the 
password requirements defined in your domain password policy. 

Database 
Connection String 

String that the InForm server uses to connect to the Oracle instance for 
the study. 

Oracle SYS DBA 
User 

The name of the Oracle SYS account. This value is only used if you 
select the Prep Oracle checkbox to create the pfdbadmin account. 

Oracle SYS DBA 
Password 

Password of the Oracle SYS account. This value is used only if you select 
the Prep Oracle checkbox to create the pfdbadmin account. 

Admin Database 
Username 

User name that is required to access the Admin database. The default is 
informadmin. 

Admin Database 
Password 

Password that is required to access the Admin database. The password is 
case-sensitive. Do not include a hyphen (-) character in the password. 
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Field Description 
InForm System 
Username 

User name for the study database. If this is a new InForm installation or 
if you change the user name from the default during the installation, 
select the Prep Oracle checkbox. This instructs the InForm software 
installation to create the InForm account using the user name and 
password you specify. 

InForm System 
Password 

Password for the study database. The password is case-sensitive. Do not 
include a hyphen (-) character in the password. 

Note: Oracle recommends that you change the InForm system 
password after installing the InForm software. For more information, 
see the Secure Configuration Guide. 

Install Admin DB If selected, creates the: 

• informadmin user, using the Admin Database Username and Admin 
Database Password. 

• InForm Admin database for non-clinical data, such as users, sites, 
and configuration information.  

Note: You must select this checkbox for both installation and upgrades. 

Prep Oracle If selected: 

• Runs the informprepora.vbs script, which creates the study 
database user, using the InForm System Username and InForm 
System Password. 

• Runs the mtsora102.vbs script, which sets up Oracle XA 
Transaction Support and sets the MTS Timeout to a minimum of 
300 seconds. 

If not selected: 

• Verifies the study database user and password. 

Note: You need to select the Prep Oracle checkbox only the first time 
you install the InForm software on an instance. 

 

18 If the Database Configuration Error window appears, click Back to return to the Database 
Configuration page to fix the incorrect information, and click Next when changes are complete. 

The Ready to Install the Program page appears. 

The installation checks both the .NET framework and ODAC, and if an upgraded version is 
required, a message appears. 

19 If you need to upgrade the .NET framework or ODAC, click Cancel to make the necessary 
corrections, and click Yes when the Exit Setup dialog box appears. 

20 If you exited the installation at the previous step, upgrade the .NET framework or ODAC 
version, and restart the installation wizard. 

21 Click Install. 

The Setup Status page appears. The progress of the installation is indicated on the screen. 
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22 If your system does not have the required hardware or software components, the Requirements 
Not Met message appears. Click Cancel to make the necessary corrections, and click Yes when 
the Exit Setup dialog box appears. 

23 If you exited the installation at the previous step, update the server with the required hardware or 
software components, and restart the installation wizard. 

24 When the setup is finished, the Oracle InForm 6.0 Reboot page appears.  

25 You must reboot the system if any of the following is true: 

• ODAC was upgraded during the installation process. 

• The PATH environment variable was modified. 

• The installation tried to access a locked file. 

26 Select Yes or No to indicate whether you want to reboot at this time, and click Finish. 

After rebooting, the final configuration process continues.  

When the system configuration is finished, the InstallShield Wizard Complete page appears. 

27 Click Finish. 
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Step 3: Update the DomainSuffix entry for the 
AuthenticationFilter registry key on the InForm Application 
Server—Optional 

If you are installing Cognos Reporting, you must update the DomainSuffix entry for the Oracle 
AuthenticationFilter registry key if any of the following is true on the InForm Application Server: 

• You use proxy servers for the Cognos Gateway Server and the InForm Application Server. 

• The fully qualified domain name (FQDN) for either server does not end with a common domain 
suffix.  

The FQDN is registered in the Oracle AuthenticationFilter DomainSuffix entry during 
installation of the InForm Application Server and the Cognos Gateway Server. If the FQDN for 
both installations ends in a common domain suffix such as .net, .com, .org, .edu, or .gov (with or 
without a country name like .uk or .au), you do not need to update the DomainSuffix entry 
unless you use proxy servers. 

• The FQDN has just two levels (for example: <servername>.com). 

Note: You must also update the DomainSuffix entry on the Cognos Gateway Server. For more 
information, see Step 4: Update the DomainSuffix entry for the AuthenticationFilter registry key 
on the Cognos Gateway Server—Public Gateway only (on page 85). 

Perform the DomainSuffix configuration on both the Cognos Gateway Server and the InForm 
Application Server. Both machines must have identical AuthenticationFilter entries for DomainSuffix. 

1 In the Windows Registry Editor, navigate to the following Windows Registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLEHS\AuthenticationFilter 

2 Update the entry for DomainSuffix: 

a Right-click the entry, and select Modify. 

The Edit String dialog box appears. 

b Enter the new value in the Value Data field. Edit the entry: 

• If you use proxy servers, or if the fully qualified domain name for either server does not 
end with a common domain suffix, remove every part of the domain suffix that is not 
identical on both computers. For example, if the FQDN includes 
<servername>.<companyname>.co.uk, after the edit, the entry would be 
<companyname>.co.uk. 

• If the InForm software and Cognos 8 BI are installed on the same machine, and the 
FQDN has only two nodes such as <servername>.com, you must include the server name 
and the domain suffix in the entry. In the above example, the entry would read 
<servername>.co.uk. 

c Click OK. 

3 Exit the Windows Registry Editor. 

4 Restart IIS.  

5 On the InForm Application Server, restart the InForm Service. 
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Step 4: Enable SSL on the InForm Application Server—
Optional 

Enabling SSL is optional. For more information, see About enabling Secure Sockets Layer (SSL) 
(on page 104). 
 



Chapter 5  Preparing the InForm Application Server  
 

58 InForm 6.0 

Qualify the installation 
Qualifying the installation verifies that the study was installed successfully. The qualification process 
consists of a set of administrative and clinical activities that perform the basic functionality of the 
InForm application. The tests are divided into Admin and CRC/CRA tests. 
 

Qualification prerequisites 
• InForm software is installed. For more information, see Step 2: Install the InForm core 

software on the InForm Application Server (on page 50). 

• Sample study PFST60 is installed, and the server and study are running. For more information, 
see the Study and Reporting Setup Guide. 

• The pfadmin setserver command has activated and assigned a password to the system user. 
For more information, see pfadmin (on page 144). 

• Passwords for dobrien and lhill users have been changed. For more information, see Change 
the passwords of the sample study users (on page 58). 

 

Change the passwords of the sample study users 
1 Log in to the PFST60 study as the system user. 

User the password you set for the system user in the pfadmin setserver command 

2 Click Admin. 

3 For the dobrien and lhill users: 

a Click the user Account Name. 

b On the Users page, deselect the User Active checkbox. 

c Click Submit, and click OK in the message box. 

d Click Change Password. 

e On the Change Password page, type a password in the New password and Confirm new 
password fields. 

Note: Use the passwords you set for lhill and dobrien when you log in to perform the 
CRF and CRA qualification tasks. 

f Click Submit, and click OK in the message box. 

g Click Return. 

h On the Basic Info for User page, select the User Active checkbox. 

i Click Submit, and click OK in the message box. 

4 Log out. 
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Admin—Users test 
 

Pass/Fail Step Description 
 1 Log in as the system user. 

 2 Click Admin. 

 3 Select each of the following: Users, Rights, Groups, Sites, Configuration, 
Events, Rules, and System. 

 4 Click Users, and verify that the following users are active: 

• lhill 

• dobrien 

• mcarlson 

 5 On the Users page, click Add User. 

 6 Enter X in the User Name field. 

In the User must change password at next login field, select No. 

Select values in the Product Locale and Preferred Study Locale fields. 

Click Submit, and click OK in the message box. 

 7 Click Return. 

Verify that user X is shown in the list. 

 8 Click the Account Name and the Group tab for user X. 

Assign a rights group and two user site associations.  

Click Submit, and click OK in the message box. 

 9 Click Return.  

Click any link for user X. 

 10 Click Change Password. 

Give user X a password with eight characters or more. 

Click Submit, and click OK in the message box. 

 11 Click Return.  

Select User Active. 

Click Submit, and click OK in the message box. 

Log out. 

 12 Log in as user X, using the password assigned in Step 10. 

Click Subjects. 

Verify that the Site drop-down list contains only the sites selected in Step 
8. 

 13 Log out. 
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Admin—Rights test 
 

Pass/Fail Step Description 
 1 Log in as the system user. 

 2 Select Rights. 

Click Add Rights Group. 

 3 Enter new rights group information. 

Click Submit, and click OK in the message box. 

 4 Click Return.  

Verify that the rights group that you just created is in the list. 
 

 

Admin—Sites test 
 

Pass/Fail Step Description 
 1 Select Sites. 

Click Add Site.  

Enter the new site information. Site Name, Site Mnemonic, and Study 
Locale are required. 

Click Submit, and click OK in the message box. 

 2 Click Return. 

Verify that the site that you just created is in the list. 
 

 

Admin—Groups test 
 

Pass/Fail Step Description 
 1 Select Groups. 

Click Add Group.  

Select Signature from the Group Type drop-down list, and type the group 
information.  

Click Submit, and click OK in the message box. 

 2 Click Return. 

Verify that the signature group you just created is in the list. 



 Installation Guide  

InForm 6.0 61 

Pass/Fail Step Description 
 3 Click Add Group. 

Select Query from the Group Type drop-down list, and enter group 
information. 

Click Submit, and click OK in the message box. 

 4 Click Return. 

Verify that the query group you just created is in the list. 
 

 

Admin—Users and Groups test 
 

Pass/Fail Step Description 
 1 Select Groups. 

In the Members column for the signature group that was created in 
the Admin—Groups test section, click Change.  

For more information, see Admin—Groups test (on page 60). 

 2 Select user X in the Available users list.  

Click Add. 

 3 Verify that user X is in the Users in (signature group) list. 

Click Submit, and click OK in the message box. 

 4 Click Return. 

Verify that the Member Count column shows 1 (and not 0) for the 
signature group. 

 5 In the Members column for the query group that was created in the 
Admin—Groups test section, click Change. 

For more information, see Admin—Groups test (on page 60). 

 6 Select user X in the Available users list. 

Click Add. 

 7 Verify that user X is in the Users in (query group) list. 

Click Submit, and click OK in the message box. 

 8 Click Return. 

Verify that the Member Count column shows 1 (not 0) for the query 
group. 

 9 Log out. 
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CRC / CRA tests 
1 Open two browser windows, using the following URL: 

http://machine_name/pfst60 
 

2 Log in to one session as dobrien (a CRC) and the other as lhill (a CRA). 

3 Perform the CRC/CRA tests. 
 

As dobrien (CRC) 
 

Pass/Fail Step Description 
 1 Click Enroll. 

Click Add Candidate. A question window appears. 

 2 Enter subject information. 

Click Submit. 

 3 Click the Screening Number for the subject who was just entered. 

Edit one of the fields, and provide a reason for change. 

Click Submit, and verify that the field you edited is changed. 

 4 Click Return. 

 5 In the Enrolled column, click the Enroll link. 

 6 Enter the subject number (site ID followed by a hyphen and a 3-digit 
number).  

Click Submit.  

The System Enrollment page displays the heading Candidate Meets All 
Criteria for Enrollment in Study. 

 7 At the bottom of the page, click Enroll. 

Verify that a Subject Schedule (Visit Calculator) page appears for the 
subject with a default baseline date of the current date. 

 8 Change the Start Date. 

Verify that the associated dates are updated correctly. 

 9 Click Go To First Visit. 

 10 Complete the DOV form. 

Click OK. 

The list of forms for the first visit appears.  

Navigate to each form in the first visit. 

 11 Click the Time and Events arrow at the left end of the visit ruler. 

View the Time and Events Schedule to check all visits for the new 
subject. 
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Pass/Fail Step Description 
 12 Click the status icon for the Base visit. 

Click the status icon for the Demographics form. 

Enter data in the form, and click Submit. 

 13 Click Return. 

Click the status icon for the Vital Signs form. 

Enter a value of 200.5 degrees Fahrenheit in the Temperature item. 

Click Submit, and verify that an autoquery is generated. (The 
background for the question becomes pink and an error message is 
shown in red.) 

 14 Click the comment icon in the right column for an item, and add a 
comment in the Comment field. 

Click Submit, and click OK in the message box. 

 15 Click Return. 

Click the query text. 

On the Queries detail page, click Update Data and Answer. 

Change the Temperature value to 98.6 and add a reason for change. 

Click Submit, and click OK in the message box. 

 16 Verify that the auto-query is answered. The background for the 
question changes from pink to gray. 

 17 Click the status icon for any form that has data.  

Select Mark SV Ready from the Select Action list, and click Apply. 

 18 Click the status icon for the Demographics form.  

Select Print Preview from the Select Action list, and click Apply. Verify 
that the preview of the form appears.  

Click Print. 

 19 Verify that the report prints with the correct information. 

 20 Click the Help icon, and select InForm User Guide. 

Verify that the User Guide is installed and functioning. 
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As dobrien (CRC) and lhill (CRA) 

Note: Keep both browsers open to make the following steps easier to perform. 

 

Pass/Fail Step Description 

 1 As lhill: 

Click Subjects. 

In the Subject column, click the link for the subject that was created by 
dobrien in the CRC test. 

Click the status icon for the Base visit. The list of forms appears. 

Click the status icon for the Demographics form. 

Create an open query on an item entered by dobrien: 

Click the query icon ( ) for the item, click Create Query, select Create 
Query in Opened State in the Action list, and select a reason. 

Click Submit, and verify that the query appears with red text in a pink 
box under the item. 

 2 As dobrien: 

Click Subjects. 

In the Subject column, click the link for the subject who was created by 
dobrien in the CRC test. 

Click the status icon for the Demographics form. 

Answer the query:  

Click the query icon or the red query text. 

In the Current Value section, click Answer. In the Query section, enter a 
response to the query. 

Click Submit, and verify that the query disappears from the form. 

 3 As lhill: 

Refresh the Demographics form: click the CRF history icon ( ), and 
select the Demographics form. 

Re-issue the answered query:  

Click the query icon, and in the Current Value section, click Reissue as 
Open.  

In the Query section, select a reason. 

Click Submit, and verify that the query reappears. 



 Installation Guide  

InForm 6.0 65 

Pass/Fail Step Description 

 4 As dobrien: 

Refresh the Demographics form: click the CRF history icon ( ), and 
select the Demographics form. 

Re-answer the query. 

Click Submit, and verify that the query disappears from the form. 

 5 As lhill: 

Refresh the Demographics form: click the CRF history icon ( ), and 
select the Demographics form. 

Close the query:  

Click the query icon, and in the Current Value section, click Close Query. 

In the Query section, select a reason. 

Click Submit, and verify that the query disappears from the form. 

 6 Log out of both browser sessions. 
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About preparing the Reporting application servers 
You must perform a specific series of steps on the reporting servers to prepare them for use with the 
InForm application. Some of the same steps are required on each server, and some steps are unique 
to the server type. 

• Oracle Directory Server 

For more information, see Steps to prepare the Oracle Directory Server (on page 69). 

• Cognos Content Manager Server 

For more information, see Steps to prepare the Cognos Content Manager Server (on page 
72). 

• Cognos Report Server 

For more information, see Steps to prepare the Cognos Report Server (on page 77). 

• Cognos Gateway Server 

For more information, see Steps to prepare the Cognos Gateway Server (on page 80). 
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Prepare the Oracle Directory Server 

Steps to prepare the Oracle Directory Server 
The Oracle Directory Server is required only if you are using Reporting. 

To prepare the Oracle Directory Server: 

1 Install the Oracle Directory Server. 

For more information, see Step 1: Install the Oracle Directory Server (on page 69). 

2 Create the ORACLEHS namespace and crnsysadmin user on the Oracle Directory Server. 

For more information, see Step 2: Create the ORACLEHS organizational unit (OU) and 
crnsysadmin user on the Oracle Directory Server (on page 70). 

Note: You must also create an ORACLEHS namespace and a crnsysadmin user on the 
Cognos Content Manager Server. For more information, see Create the ORACLEHS LDAP 
namespace (on page 101). 

 

Step 1: Install the Oracle Directory Server 
1 Download and install the Oracle Directory Server. 

2 Configure and deploy the Oracle Directory Server to a supported web server. 

For more information, see the Oracle website, the Oracle Directory Server Enterprise Edition 
documentation, or your Oracle database documentation. 
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Step 2: Create the ORACLEHS organizational unit (OU) and crnsysadmin user 
on the Oracle Directory Server 

If you are using Reporting, you must create an ORACLEHS namespace and crnsysadmin user on the 
Cognos Content Manager Server and the Cognos Report Server. For more information, see Create 
the ORACLEHS LDAP namespace (on page 101). 

1 On the server where the Oracle Directory Server is installed, use the Cognos Configuration 
utility to ensure that the Cognos 8 Business Intelligence Service is stopped. 

2 Launch the URL for the Oracle Directory Server and log in to the Oracle Directory Service 
Control Center. 

3 Select the Directory Server tab. In the Directory Servers list, click the server name. 

The Server Operations tab opens. 

4 Select the Entry Management tab. 

5 Select the DN from the Browse Data list, and click New Entry. 

The New Entry wizard page displays the Specify Entry Location page. 

6 Make sure that the Entry Parent DN is correct, and click wizard button next. 

The Choose Object Class page appears. 

7 Select Organizational Unit - (organizationalUnit) from the Entry Type drop-down list, and click 
wizard button next. 

The Configure Attributes page appears. 

8 In the Organizational Unit (ou) field, type ORACLEHS (all uppercase), and click wizard button 
next. 

The Summary page appears. 

9 Review the information. If it is correct, click wizard button finish. 

The ORACLEHS node is added to the Browse Data list. 

10 On the Entry Management tab, right-click ou=ORACLEHS in the Browse Data list, and click 
New Entry. 

The New Entry wizard displays the Specify Entry Location page. 

11 Make sure that the Entry Parent DN is correct, and click wizard button next. 

The Choose Object Class page appears. 

12 Select User - (inetOrgPerson) from the Entry Type drop-down list, and click wizard button next. 

The Configure Attributes page appears. 

13 Create a new user for the ORACLEHS namespace as follows:  

• Full Name (cn)—crnsysadmin 

• Last Name (sn)—crnsysadmin 

• User ID (uid)—crnsysadmin 

• Password (userPassword)—<crnsysadmin password> 
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• Confirm Password—<crnsysadmin password> 

14 Click wizard button next. 

The Summary page appears. 

15 Review the information. If it is correct, click wizard button finish. 

The uid=crnsysadmin node is displayed in the Browse Data list on the Entry Management tab. 
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Prepare the Cognos Content Manager Server 

Steps to prepare the Cognos Content Manager Server 
All InForm installations with Reporting use a Cognos Content Manager Server. 

To prepare the Cognos Content Manager Server: 

1 Verify the Oracle database client. 

This step is performed on multiple servers. 

For more information, see Step 1: Verify the Oracle database client on the Cognos Content 
Manager Server (on page 73). 

2 Install the Cognos software and updates. 

This step is performed on multiple servers. 

For more information, see Step 2: Install the Cognos software and updates on the Cognos 
Content Manager Server (on page 73). 

3 Set up JRE. 

This step is performed on multiple servers. 

For more information, see Step 3: Set up JRE on the Cognos Content Manager Server (on 
page 73). 

4 Set up the Oracle JDBC driver. 

This step is performed on multiple servers. 

For more information, see Step 4: Set up the Oracle JDBC driver (on page 74). 

5 Run the CRNConfig installer. 

This step is performed on multiple servers. 

For more information, see Step 5: Run the Cognos Customization for InForm wizard 
(CRNConfig\setup.exe) on the Cognos Content Manager Server (on page 74). 

6 Create the ORACLEHS LDAP namespaces on the Cognos Content Manager Server. 

This step is performed on multiple servers. 

For more information, see Step 6: Create the ORACLEHS LDAP namespace on the 
Cognos Content Manager Server (on page 74). 

7 Configure MotioCAP—Optional. 

This step is performed only on the Cognos Content Manager Server. 

For more information, see Step 7: Change or create a new MotioCAP_informcap.properties 
file—Optional (on page 75). 

8 Customize the Cognos email settings. 

This step is performed on multiple servers. 

For more information, see Step 8: Customize the Cognos 8 BI email settings on the 
Cognos Content Manager Server (on page 76). 

9 Enable SSL—Optional. 



 Installation Guide  

InForm 6.0 73 

This step is performed on multiple servers. 

For more information, see Step 9: Enable SSL on the Cognos Content Manager Server—
Optional (on page 76). 

 

Step 1: Verify the Oracle database client on the Cognos Content Manager 
Server 

Before you begin, ensure that you have followed the instructions in Steps to install and configure 
the Oracle database client (on page 40) so that the following requirements are met on the Cognos 
Content Manager Server: 

• The Oracle database client is installed. 

• The language registry settings are updated. 

• The database connection is configured and verified. 

Note: This step is also performed on the Cognos Report Server. 
 

Step 2: Install the Cognos software and updates on the Cognos Content 
Manager Server 

To install the Cognos software and updates on the Cognos Content Manager Server, you must: 

• Install the Cognos core software. 

• Upgrade the Fix Pack. 

• Install the hotsite updates. 

This step is also performed on the Cognos Report Server and the Cognos Gateway Server. 

For more information, see Install the Cognos software and updates—Cognos Content 
Manager / Cognos Report Server / Cognos Gateway Server (on page 87). 
 

Step 3: Set up JRE on the Cognos Content Manager Server 
To enable the Cognos software to find the necessary Java components when it runs, you must set the 
JAVA_HOME environment variable on the Cognos Content Manager Server. 

This step is also performed on the Cognos Report Server and the Cognos Gateway server. 

For more information, see Add the JRE to the JAVA_HOME environment variable (on page 
92). 
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Step 4: Set up the Oracle JDBC driver 
Before running the Cognos Customization for InForm wizard, you must set up the Oracle JDBC 
driver on the Content Manager Server. 

1 Download the ojdbc6.jar file from the Oracle support website. 

2 Copy the ojdbc6.jar file to the <Cognos_Installation_Directory>\webapps\p2pd\WEB-
INF\lib folder. 

 

Step 5: Run the Cognos Customization for InForm wizard 
(CRNConfig\setup.exe) on the Cognos Content Manager Server 

The Cognos customization wizard copies customization files and modifies files needed to customize 
the Cognos 8 BI software for the InForm application. 

This step is also performed on the Cognos Report Server. 

For more information, see Run the Cognos Customization for InForm wizard 
(CRNConfig\setup.exe)—Cognos Content Manager / Cognos Report Server (on page 92). 
 

Step 6: Create the ORACLEHS LDAP namespace on the Cognos Content 
Manager Server 

This procedure sets up the following namespaces on the Cognos Content Manager Server: 

• ORACLEHS 

For more information, see Create the ORACLEHS LDAP namespace (on page 101). 
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Step 7: Change or create a new MotioCAP_informcap.properties file—Optional 
The Cognos Customization for InForm wizard creates the MotioCAP_informcap.properties file. 
The information in the file is used to configure the custom authentication provider’s connection to 
the Oracle Directory Server (LDAP). 

In most cases you do not need to change the MotioCAP_informcap.properties file. However, the 
following table lists some examples of when you need to make changes to the file. 

 

Circumstances that 
require changes to file 

Required action 

LDAP configuration 
changes after installation. 

Change the LDAP properties used for authenticating the admin OU: 

• ldap.url—Enter the URL of the server where LDAP is installed. 
Change the number of the LDAP port if necessary. 

Example: ldap.url=ldap://ldap.north.com:389 

• ldap.base.dn—Enter the Parent Node Distinguished Name. 

Example: ldap.base.dn=dc=north,dc=com 

• ldap.bind.username—Enter the Administrator Distinguished 
Name. This is used by the Custom Security Provider (CSP) to 
log on to LDAP.  

Example: 
ldap.bind.username=uid=admin,ou=Administrators, 
ou=TopologyManagement,o=NetscapeRoot 

• ldap.bind.password—Change encrypted to unencrypted and 
set the password in plain text. The password is encrypted when 
Cognos Reporting starts up. 

Example: ldap.bind.password=unencrypted:password 

New namespace is added 
after the Cognos 8 Business 
Intelligence configuration. 

Duplicate and edit the file for each namespace as follows: 

Copy the MotioCAP_informcap.properties file and save it to the 
same directory as the original. Name the new copy 
MotioCAP_<new_namespace_name>.properties and edit the 
following properties as necessary: 

• ldap.url 

• ldap.base.dn 

• ldap.bind.username 

• ldap.bind.password 
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Circumstances that 
require changes to file 

Required action 

The database user and/or 
database user password 
changes after installation. 

Change the properties as follows: 

• db.user 

Example: db.user=encrypted:<db_username> 

• db.password 

Example: db.password=encrypted:<db_user_password> 

Change encrypted to unencrypted and set the password in plain 
text. The password is encrypted when Cognos Reporting starts up. 

 
 

Step 8: Customize the Cognos 8 BI email settings on the Cognos Content 
Manager Server 

The Cognos 8 Business Intelligence installation includes a feature that you can use to send links to 
report output notifications using email. Normally, you configure email to point to the Cognos 
Gateway server. However, if your environment uses an F5 switch that requires a generic URL to 
access the switch, you must configure the SMTP server to use the correct address. 

1 Using the Cognos Configuration utility, configure the SMTP mail server. 

For more information, see the Cognos 8 BI Reporting Quick Start Installation and Configuration Guide. 

2 Select File > Save. 

The Cognos Configuration utility validates the settings and saves the configuration. 

3 When the validation checks are complete (all items are marked with a green check mark), click 
Close. 

4 Click Close, and close the Cognos Configuration utility window. 
 

Step 9: Enable SSL on the Cognos Content Manager Server—Optional 
Enabling SSL is optional. For more information, see About enabling Secure Sockets Layer (SSL) 
(on page 104). 
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Prepare the Cognos Report Server 

Steps to prepare the Cognos Report Server 
All InForm installations with Reporting use a Cognos Report Server. 

To prepare the Cognos Report Server: 

1 Verify the Oracle database client. 

This step is performed on multiple servers. 

For more information, see Step 1: Verify the Oracle database client on the Cognos Report 
Server (on page 78). 

2 Install the Cognos software and updates. 

This step is performed on multiple servers. 

For more information, see Step 2: Install the Cognos software and updates on the Cognos 
Report Server (on page 78). 

3 Set up JRE. 

This step is performed on multiple servers. 

For more information, see Step 3: Set up JRE on the Cognos Report Server (on page 78). 

4 Set up the JDBC driver. 

This step is performed on multiple servers. 

For more information, see Step 4: Set up the Oracle JDBC driver (on page 78). 

5 Run the CRNConfig Installer. 

This step is performed on multiple servers. 

For more information, see Step 5: Run the Cognos Customization for InForm wizard 
(CRNConfig\setup.exe) on the Cognos Report Server (on page 79). 

6 Enable SSL—Optional. 

This step is performed on multiple servers. 

For more information, see Step 6: Enable SSL on the Cognos Report Server—Optional (on 
page 79). 
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Step 1: Verify the Oracle database client on the Cognos Report Server 
Before you begin, ensure that you have followed the instructions in Steps to install and configure 
the Oracle database client (on page 40) so that the following requirements are met on the Cognos 
Report Server: 

• The Oracle database client is installed. 

• The language registry settings are updated. 

• The database connection is configured and verified. 

Note: This step is also performed on the Cognos Content Manager Server and the Cognos Gateway 
Server. 
 

Step 2: Install the Cognos software and updates on the Cognos Report Server 
To install the Cognos software and updates on the Cognos Report Server, you must: 

• Install the Cognos core software. 

• Upgrade the Fix Pack. 

• Install the hotsite updates. 

This step is also performed on the Cognos Content Manager Server and the Cognos Gateway Server. 

For more information, see Install the Cognos software and updates—Cognos Content 
Manager / Cognos Report Server / Cognos Gateway Server (on page 87). 
 

Step 3: Set up JRE on the Cognos Report Server 
To enable the Cognos software to find the necessary Java components when it runs, you must set the 
JAVA_HOME environment variable on the Cognos Report Server. 

This step is also performed on the Cognos Content Manager Server and the Cognos Gateway Server. 

For more information, see Add the JRE to the JAVA_HOME environment variable (on page 
92). 
 

Step 4: Set up the Oracle JDBC driver 
Before running the Cognos Customization for InForm wizard, you must set up the Oracle JDBC 
driver on the Report Content Server. 

1 Download the ojdbc6.jar file from the Oracle support website. 

2 Copy the ojdbc6.jar file to the <Cognos_Installation_Directory>\webapps\p2pd\WEB-
INF\lib folder. 
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Step 5: Run the Cognos Customization for InForm wizard 
(CRNConfig\setup.exe) on the Cognos Report Server 

The Cognos customization wizard copies customization files and modifies files needed to customize 
the Cognos 8 BI software for the InForm application. 

This step is also performed on the Cognos Content Manager Server. 

For more information, see Run the Cognos Customization for InForm wizard 
(CRNConfig\setup.exe)—Cognos Content Manager / Cognos Report Server (on page 92). 
 

Step 6: Enable SSL on the Cognos Report Server—Optional 
Enabling SSL is optional. For more information, see About enabling Secure Sockets Layer (SSL) 
(on page 104). 
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Prepare the Cognos Gateway Server 

Steps to prepare the Cognos Gateway Server 
All InForm installations with Reporting use a Cognos Gateway Server. The required steps are the 
same whether you are using a private or public gateway, except where noted. 

To prepare the Cognos Gateway Server: 

1 Install the Cognos software and updates. 

This step is performed on multiple servers. 

For more information, see Step 1: Install the Cognos software and updates on the Cognos 
Gateway Server (on page 81). 

2 Set up the JRE on the Cognos Gateway Server. 

This step is performed on multiple servers. 

For more information, see Step 2: Set up JRE on the Cognos Gateway Server (on page 81). 

3 Run the Cognos Gateway Customization for InForm wizard (CRNGatewayConfig\setup.exe). 

This step is performed only on the Cognos Gateway Server. 

For more information, see Step 3: Run the Cognos Gateway Customization for InForm 
wizard (CRNGatewayConfig\setup.exe) on the Cognos Gateway Server (on page 82). 

4 Update the DomainSuffix entry for the AuthenticationFilter registry key on the Cognos Gateway 
Server—Public Gateway only. 

This step is performed on multiple servers. 

For more information, see Step 4: Update the DomainSuffix entry for the 
AuthenticationFilter registry key on the Cognos Gateway Server—Public Gateway only 
(on page 85). 

Note: You must also update the DomainSuffix entry on the InForm Application Server. For 
more information, see Step 3: Update the DomainSuffix entry for the AuthenticationFilter 
registry key on the InForm Application Server—Optional (on page 56). 

5 Enable SSL—Optional. 

This step is performed on multiple servers. 

For more information, see Step 5: Enable SSL on the Cognos Gateway Server—Optional—
Public Gateway only (on page 86). 
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Step 1: Install the Cognos software and updates on the Cognos Gateway Server 
To install the Cognos software and updates on the Cognos Gateway Server, you must: 

• Install the Cognos core software. 

• Upgrade the Fix Pack. 

• Install the hotsite updates. 

This step is also performed on the Cognos Content Manager Server and the Cognos Report Server. 

For more information, see Install the Cognos software and updates—Cognos Content 
Manager / Cognos Report Server / Cognos Gateway Server (on page 87). 
 

Step 2: Set up JRE on the Cognos Gateway Server 
To enable the Cognos software to find the necessary Java components when it runs, you must set the 
JAVA_HOME environment variable on the Cognos Gateway Server. 

This step is also performed on the Cognos Content Manager Server and the Cognos Report Server. 

For more information, see Add the JRE to the JAVA_HOME environment variable (on page 
92). 
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Step 3: Run the Cognos Gateway Customization for InForm wizard 
(CRNGatewayConfig\setup.exe) on the Cognos Gateway Server 

The Cognos Gateway Customization for InForm wizard configures the Cognos 8 BI Gateway 
services component to work with the InForm application.  

Note: You run this wizard to configure a public gateway to be used with the Reporting and 
Analysis module, or to configure a private gateway with restricted access to the Cognos 8 
Business Intelligence software. 

1 Copy the CRNGatewayConfig folder from the InForm installation image to a location that you 
can access from the Cognos Gateway Server. 

2 On the Cognos Gateway Server, run the CRNGatewayConfig\setup.exe program file. 

The Choose Setup Language page appears.  
 

 
 

3 Select the language you want the wizard to use during setup. Select either English or Japanese. 
English is the default. Click Next.  

The Cognos 8 BI Welcome Screen appears.  

4 Click Next. 

The Cognos 8 BI Installation Location page appears. 

5 Specify the path to the location of the Cognos 8 BI software, and click Next. 
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The Java Runtime Environment Information page appears. 
 

 
 

6 Browse to the location where the JRE is installed, and click Next. 

The Setup Type page appears. 
 

 



Chapter 6  Preparing the Reporting application servers  
 

84 InForm 6.0 

 

7 Do one of the following, and click Next. 

• Select Public Gateway to set up a gateway to manage communication between the InForm 
application and the Reporting and Analysis module. 

• Select Private Gateway (Admin Only) to perform administrative functions on the Cognos 8 
Business Intelligence software. 

Note: Access to a Private Gateway server should be restricted to a limited group of 
users who need to administer the Cognos 8 Business Intelligence software. 

The Cognos 8 BI Setup File Locations page appears. 
 

 
 

8 Browse to the CRNSetup.xml and the singledesignonproperties.xml files that were created by the 
Cognos 8 BI Customization for InForm wizard, and click Next. 

The Ready to Install the Program page appears. 

9 Click Install.  

The Setup Status page appears. 

The program installs, and the World Wide Web Publishing Service restarts. 

The Wizard Complete page appears. 

10 Click Finish. 
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Step 4: Update the DomainSuffix entry for the AuthenticationFilter registry key 
on the Cognos Gateway Server—Public Gateway only 

If you are installing Cognos Reporting, you must update the DomainSuffix entry for the Oracle 
AuthenticationFilter registry key if any of the following is true on the Cognos Gateway Server: 

• You use proxy servers for the Cognos Gateway Server and the InForm Application Server. 

• The fully qualified domain name (FQDN) for either server does not end with a common domain 
suffix.  

The FQDN is registered in the Oracle AuthenticationFilter DomainSuffix entry during 
installation of the InForm Application Server and the Cognos Gateway Server. If the FQDN for 
both installations ends in a common domain suffix such as .net, .com, .org, .edu, or .gov (with or 
without a country name like .uk or .au), you do not need to update the DomainSuffix entry 
unless you use proxy servers. 

• The FQDN has just two levels (for example: <servername>.com). 

Note: You must also update the DomainSuffix entry on the InForm Application Server. For more 
information, see Step 3: Update the DomainSuffix entry for the AuthenticationFilter registry key 
on the InForm Application Server—Optional (on page 56). 

Perform the DomainSuffix configuration on both the Cognos Gateway Server and the InForm 
Application Server. Both machines must have identical AuthenticationFilter entries for DomainSuffix. 

1 In the Windows Registry Editor, navigate to the following Windows Registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\WoW6432Node\ORACLEHS\AuthenticationFil
ter 

2 Update the entry for DomainSuffix: 

a Right-click the entry, and select Modify. 

The Edit String dialog box appears. 

b Enter the new value in the Value Data field. Edit the entry: 

• If you use proxy servers, or if the fully qualified domain name for either server does not 
end with a common domain suffix, remove every part of the domain suffix that is not 
identical on both computers. For example, if the FQDN includes 
<servername>.<companyname>.co.uk, after the edit, the entry would be 
<companyname>.co.uk. 

• If the InForm software and Cognos 8 BI are installed on the same machine, and the 
FQDN has only two nodes such as <servername>.com, you must include the server name 
and the domain suffix in the entry. In the above example, the entry would read 
<servername>.co.uk. 

c Click OK. 

3 Exit the Windows Registry Editor. 

4 Restart IIS.  

5 On the InForm Application Server, restart the InForm Service. 
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Step 5: Enable SSL on the Cognos Gateway Server—Optional—Public Gateway 
only 

Enabling SSL is optional. For more information, see About enabling Secure Sockets Layer (SSL) 
(on page 104). 
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Common steps for Reporting application servers 

Install the Cognos software and updates—Cognos Content Manager / Cognos 
Report Server / Cognos Gateway Server 

The Cognos 8 BI software installation process installs: 

• Cognos 8 BI Application Tier Components 

• Cognos 8 BI Gateway services 

• Cognos 8 BI Content Manager 

You install the Cognos software and updates on the following Reporting servers: 

• Cognos Content Manager Server 

For more information, see Step 2: Install the Cognos software and updates on the Cognos 
Content Manager Server (on page 73). 

• Cognos Report Server 

For more information, see Step 2: Install the Cognos software and updates on the Cognos 
Report Server (on page 78). 

• Cognos Gateway Server 

For more information, see Step 1: Install the Cognos software and updates on the Cognos 
Gateway Server (on page 81). 

 



Chapter 6  Preparing the Reporting application servers  
 

88 InForm 6.0 

Install the Cognos 8.4.1 software 
You install the Cognos software on the following reporting servers: 

• Cognos Content Manager Server 

• Cognos Report Server 

• Cognos Gateway Server 

1 Download the BiReportingWin64_CZAG2ML.tar.gz file from the Oracle Download Center, 
extract the archive file, and navigate to the issetup.exe file in the \Win32 folder. 

2 Double-click issetup.exe. 

The Welcome page of the installation wizard appears. 

3 Select the language to use for the installation, and click Next. 

The License Agreement page appears. 

4 Read the license agreement, select I accept, and click Next. 

The Installation Location page appears. 

5 In the Installation Directory field, browse to or type the drive and destination folder for 
Cognos 8 Business Intelligence (for example E:\cognos\c8), and click Next.  

If the Folder does not exist message appears, click Yes to create the folder. 

The Component Selection page appears. 
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6 Select the appropriate component or components depending on your server configuration.  

For example, in a distributed environment you would: 

• Select Application Tier Components for the Cognos Report Server. 

• Select Gateway for the Cognos Gateway Server. 

• Select Content Manager for the Cognos Content Manager Server. 

7 Make sure that the Cognos Content Database is not selected, and click Next. 

The Shortcut Folder page appears. 

8 Accept the default Program folder, and click Next. 

The Installation Summary page appears. 

9 Review the installation summary, and click Next. 

The installation program installs the components that you selected. This takes several minutes. 
When the component installation is complete, the Finish page appears. 

 

 
 

10 On the Finish page: 

• To view the transfer log or the summary-error log, click the appropriate View button. 

• To view the readme file, select View Cognos Readme. 

• Verify that Start Cognos Configuration is not selected.  

11 Click Finish. 
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Upgrade Cognos 8.4.1 software to Fix Pack 4 
You install the Cognos software fix packs on the following reporting servers: 

• Cognos Content Manager Server 

• Cognos Report Server 

• Cognos Gateway Server 

1 Download the C8_BI_8_4_1_Win64_FP004.tar.gz file from the Oracle Download Center, 
extract the archive file into a different folder from the folder where you originally downloaded 
the Cognos 8.4.1 software, and navigate to the issetup.exe file in the \Win32 folder. 

2 Double-click issetup.exe. 

The Welcome page of the upgrade wizard appears. 

3 Select the language to use for the installation. English is the default. Click Next. 

The License Agreement page appears. 

4 Read the license agreement, select I accept, and click Next. 

The Installation Location page appears. 

5 In the Installation Directory field, browse to or type the same drive and destination folder that 
you specified for the initial installation of Cognos 8 Business Intelligence (for example 
C:\cognos\c8), and click Next.  

The following warning appears: 
The installation will replace existing files. 
Select 'Yes' to automatically create a backup of all files that are 
replaced. 
 

6 Click Yes. 

The Shortcut Folder page appears. 

7 Accept the default Program folder, and click Next. 

The Installation Summary page appears. 

8 Review the installation summary, and click Next. 

When the installation is complete, the Finish page appears. 

9 To review the transfer log or summary-error log, click the appropriate View button. 

10 Click Finish. 
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Install the 8.4.1 Fix Pack 4 hotsite updates 
In addition to the upgrade to Fix Pack 4 of the Cognos 8 BI software, you must install the following 
hotsite updates: 

• up_c8bisrvr_winx64_8.4.105.1076_ml.tar.gz 

• up_c8bisrvr_winx64_8.4.105.1100_ml.tar.gz 

You install the Cognos software hotsite updates on the following reporting servers: 

• Cognos Content Manager Server 

• Cognos Report Server 

• Cognos Gateway Server 

1 Download each hotsite TAR file from the Oracle Download Center, extracting each archive file 
into a different folder from the folder where you originally downloaded the Cognos 8.4.1 
software and the other hotsites. 

You must perform this procedure for each hotsite update. The following hotsites are required 
for this Cognos installation, and must be installed in the following order: 

a 8.4.105.1076 

b 8.4.105.1100 

2 Navigate to the ...\win32 folder for each hotsite, and double-click issetup.exe. 

The Welcome page of the upgrade wizard appears. 

3 Select the language to use for the installation, and click Next. English is the default language. 

The License Agreement page appears. 

4 Read the license agreement, select I accept, and click Next. 

The Installation Location page appears. 

5 In the Installation Directory field, browse to or type the same drive and destination folder that 
you specified for the initial installation of the Cognos 8 Business Intelligence software (for 
example C:\cognos\c8), and click Next.  

The following message appears: 
The installation will replace existing files. 
Select 'Yes' to automatically create a backup of all files that are 
replaced. 
 

6 Click Yes. 

The Shortcut Folder page appears. 

7 Accept the default Program folder, and click Next. 

The Installation Summary page appears. 

8 Review the installation summary, and click Next. 

When the installation is complete, the Finish page appears. 
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9 To review the transfer log or summary-error log, click the appropriate View button. 

10 Click Finish. 

11 Repeat this procedure for each of the hotsites listed in Step 1. 
 

Add the JRE to the JAVA_HOME environment variable 
Set the JAVA_HOME environment variable to the path for the Java Runtime Environment 1.6 (for 
example, C:\Program Files\Java\jre6) on the following reporting servers: 

• Cognos Content Manager Server 

For more information, see Step 3: Set up JRE on the Cognos Content Manager Server (on 
page 73). 

• Cognos Report Server 

For more information, see Step 3: Set up JRE on the Cognos Report Server (on page 78). 

• Cognos Gateway Server 

For more information, see Step 2: Set up JRE on the Cognos Gateway Server (on page 81). 
 

Run the Cognos Customization for InForm wizard (CRNConfig\setup.exe)—
Cognos Content Manager / Cognos Report Server 

To customize the Cognos 8 BI software for the InForm environment, you run installation and 
configuration wizards. 

You run the Cognos Customization for InForm wizard (CRNConfig\setup.exe) on the following 
reporting servers: 

• Cognos Content Manager Server 

For more information, see Step 5: Run the Cognos Customization for InForm wizard 
(CRNConfig\setup.exe) on the Cognos Content Manager Server (on page 74). 

• Cognos Report Server 

For more information, see Step 5: Run the Cognos Customization for InForm wizard 
(CRNConfig\setup.exe) on the Cognos Report Server (on page 79). 

1 Copy the CRNConfig folder from the InForm installation image to a location that you can 
access from the Cognos Content Manager Server and the Cognos Report Server. 

2 On the Cognos Content Manager Server and the Cognos Report Server, run the 
CRNConfig\setup.exe program file. 
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The Choose Setup Language window appears. 
 

 
 

3 Select the language you want the wizard to use during setup. Select either English or Japanese. 
English is the default. Click Next.  

The Welcome page appears.  

4 Click Next.  

The Cognos 8 BI Installation Location page appears. 

5 Specify the folder in which the Cognos 8 BI Content Manager is installed, and click Next.  
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The Java Runtime Environment (JRE) Version Information page appears. 
 

 
 

6 Browse to the location where the JRE is installed, and click Next. 
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The Setup Type page appears. 
 

 
 

7 Select the memory model (Small, Medium, or Large) that is most appropriate for your business, 
and click Next. 

Note: You can change this later if you select the wrong size. 
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The Cognos Content Store and Application Firewall page appears. 
 

 
 

8 Enter the following values. 
 

Field Description 
Database server Fully qualified domain name of the database server where the 

Cognos 8 BI Content Store schema is installed. 

Port Port number for communicating with the database server. 

SID SID for communicating with the database server. 

User Name User name of the Oracle user in the Cognos 8 BI content store 
database. You created this user when you configured the Cognos 8 
BI content store database. 

Password, Confirm 
Password 

Cognos 8 BI user in the Cognos content store database.  

Valid Domain or Host Comma-separated list of domain or host names, for example 
*.company.com,*.companycorp.com. 

 

9 Click Next.  
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The Custom Authentication Provider Configuration and Single Sign-On Information page 
appears. 

 

 
 

10 Enter the following values. 
 

Field Description 
Database server Fully qualified domain name of the user that contains the 

TRIAL_URLS table. 

Port Port number for communicating with the database server. 

SID SID for communicating with the database server. 

User Name The name of the PFCapAdmin user. 

Password, Confirm Password Password of the PFCapAdmin user. 

Trust the user for InForm 
Model Generation Service (No 
Authentication Required) 

Select to allow the pfreportinguser to have access to the 
InForm Model Generation Service. 

Integrated with Single Sign-on Select to enable Single Sign-on. 

Cognos Content Manager 
Component is installed on the 
computer 

Select if you are enabling SSO, and you are installing the 
CRNConfig wizard on the Content Manager Server. 

OAM ASDK Install Location If you are using SSO, enter the path to the Oracle Access 
Management Access SDK location. 
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11 Select Trust the user for InForm Model Generation Service (No Authentication Required). 

12 Click Next. 

The Specify the Cognos Web Server (gateway or IIS server) page appears. 
 

 
 

13 Type the fully qualified domain name of the Cognos 8 BI Gateway server, or click Browse to 
select it from the dialog box. 

14 Click Next.  
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The LDAP Configuration Information page appears. 
 

 
 

15 Enter the following values. 
 

Field Description 
LDAP Server Fully qualified domain name of the server where the Oracle 

Directory Server is installed. 

LDAP Port Port number used to communicate with the LDAP server. 

Administrator DN Distinguished Name of the administrator of the server. Use the 
format and values shown beneath the field. 

Note: The Administrator DN value corresponds to an LDAP user 
who has READ and SEARCH access to the Base Distinguished 
Name (BDN). The BDN specifies the top level or root of the 
directory structure, which is the starting place for searches. 

Password, Confirm 
Password 

Password of the administrator. 

Parent Node DN Distinguished name of the Parent Node. Use the format shown 
beneath the field. (Do not enter spaces after the commas between 
the parts of the domain.) 

Note: The Parent Node DN is also known as the Base 
Distinguished Name (BDN). The BDN specifies the top level or 
root of the directory structure, which is the starting place for 
searches. 
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Field Description 
Cognos Admin OU The Cognos Admin organizational unit. 

 

16 Click Next.  

The Ready to Install the Program page appears. 

17 Click Install.  

The Setup Status page appears.  

The program copies the necessary files and creates the CRNSetup.xml and 
singlesignonproperties.xml files in an InForm subfolder under the Cognos 8 installation 
(...\InForm\Config). The name and location of the files appears in a message window. You need 
to supply the location of these files when you install the Cognos 8 BI Gateway Customization 
for InForm. 

18 The Wizard Complete page appears. 

19 Click Finish. 
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Create the ORACLEHS LDAP namespace 
You create the ORACLEHS LDAP namespace on the Cognos Content Manager Server. For more 
information, see Step 6: Create the ORACLEHS LDAP namespace on the Content Manager 
Server (on page 74). 

Run this procedure each time you run the InForm CRNConfig wizard. 

1 On the server where Cognos 8 BI is installed, select Start > All Programs > Cognos 8 > Cognos 
Configuration. 

The Cognos Configuration window appears. 

2 In the Security tree, right-click Authentication, and select New resource > Namespace. 

The New Resource - Namespace dialog box appears. 

3 Enter the following values: 

• Name—ORACLEHS (all uppercase) 

• Type—LDAP 

4 Click OK.  

5 Complete the parameters as follows: 

• Namespace ID—ORACLEHS 

• Host and Port—<fullyqualifiedmachinename>: <LDAPServerPort>  

(For example, port number: 389) 

• Base distinguished name—Domain name for your environment. For example, if the 
network domain is hof.com, ou=ORACLEHS,dc=hof,dc=com 

Note: Do not enter spaces after the commas between the parts of the domain. 

• User lookup—(uid=${userID}) 

6 Select File > Save. 

The Cognos Configuration utility validates the settings and saves the configuration. 

7 When the validation checks are complete (all items are marked with a green check mark), click 
Close. 

8 Click Close, and close the Cognos Configuration utility window. 
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About enabling Secure Sockets Layer (SSL) 
Secure Sockets Layer (SSL) enables secure communications between servers. 

Enabling SSL is optional. However, Oracle recommends that you enable SSL for all InForm 
installations. 

If you choose to use SSL, you must set up your environment to support SSL on all servers, and then 
you must enable SSL to be active in each study. 

If you are using Cognos Reporting: 

• You can enable SSL on the InForm servers when you install the InForm core software. 

• You can enable SSL on the Reporting servers after you install them, or wait until after the 
Cognos installations are complete, and then enable SSL on all of the servers. 
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Set up your environment to support SSL 
To enable your InForm installation to use SSL, perform the following steps on all servers.  

1 Create and set up a key certificate. 

2 Install key certificates. 

3 Import key certificates. 

4 Verify the key certificate installation. 

If you are using Reporting and are using a SameDB configuration, perform the following additional 
steps on the InForm Application Server and the Cognos Gateway Server: 

1 Update the ExternalLoginURL on the InForm Application Server. 

Note: This step is required only if the InForm and Reporting applications are installed on the 
same application server. 

2 Configure Cognos Report Server and Cognos Content Manager to use SSL. 

3 Configure the Cognos Gateway Server to use SSL. 

Note: This step is required only if you are using Reporting and using a public gateway. 
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Steps to perform on all servers 
If you choose to use SSL, you must set up key certificates on all servers, regardless of your 
configuration. 
 

Create and set up a key certificate for SSL in IIS 
1 Open Internet Information Services (IIS) Manager. 

2 Open the <machine_name> node. 

3 Go to the IIS Group > Feature View and select Server Certificate. 

4 From the Actions view, click Open Features. 

5 From the resulting Actions view, select Create Certificate Request. 

6 The Request Certificate Wizard opens. 

7 Complete the Request Certificate page. Specify the name of the study server in the Common 
name field, including the FQDN (for example: <machine_name>.north.com). 

8 Click Next. 

9 Leave all default values in Cryptographic Service Provider Properties and click Next. 

10 Click Browse. 

11 Specify the certificate request name and folder details. 

12 Click Save.  

13 Click Open. The file name appears in the text box. 

14 Click Finish. 
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Install a key certificate on the server machine in IIS 
1 Open your browser and go to the security certificate server URL: 

http://<Windows_2008_security_certificate_server>/<certificate _request_page>.  

2 Click Request a certificate. 

3 Click Advanced certificate request. 

4 Click Submit a certificate request by using a base-64-encoded. 

5 Copy all the text in certreq.txt file in the first text field of the saved request.  

6 Click Submit.  

7 Select Base 64 encoded. 

8 Click Download certificate.  

9 Save to c:\certnew.cer. 

10 Click Download certificate chain. 

11 Save to c:\certnew.p7b. 

12 Go to Internet Information Services Manager to complete the certificate request. 

13 Select the <machine_name> node. 

14 From the Feature View, select Server Certificate under IIS group. 

15 From the Actions view, select Open Feature. 

16 From the Actions view, select Complete Certificate Request. 

17 Browse to c:\certnew.cer and give the Friendly name as machine name, and click Next. 

18 Set the SSL port to the port number for the study server. The default is 443.  

19 Click OK. 

20  Go to C:\ directory. Right click on c:\certnew.p7b. 

21 Select Install Certificate, and click Next.  

22 Click Next again, and click Finish. 

23 Click Yes in the Security Warning dialog box. 

24 Click OK on the confirmation dialog box. 

25 Set the Binding for Default Websites. 

26 Go to IIS Manager. 

27 Select the <machine_name> node. 

28 Open the Web Sites node.  

29 Click Edit Site > Bindings, and click Add. 

30 Select the certificate type as Https and SSL. 

31 Click View. Verify that there is no red exclamation mark for the Certificate. 
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Import the new key certificate to the local computer and the current user 
1 Go to Start > Run, and type mmc. 

2 From the Console screen, go to file > Add/Remove Snap-in. 

3 Click Available snap-ins > Certificates > Add. 

4 Select My user account, and select Finish. 

5 Click Available snap-ins > Certificates > Add. 

6 Select Computer account, select Next > Finish, and click OK. 

7 Go to Certificates > Current User. 

8 Expand Trusted Root Certificate Authorities. 

9 Right-click Certificates and select Import. 

10 Browse to the certificate you created, select it, and complete the wizard, using all defaults. 

11 Repeat steps 8 through 10 for Certificates > Local Computer. 

Note: Make sure <Windows_2008_security_certificate_server> is listed in the trusted roots 
of the certificate store for both the current user and the local computer. If it is not there, 
export it from the current user, save it to the disk, and import it to the local computer. 

 

Verify the key certificate installation 
1 Open a browser window. 

2 Type: 
https://<machine_name>.<domain_name>.com 

 
The Security Alert window appears.  

3 Verify that the date and name for the certificate are valid. 
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Additional steps to perform if you are using Reporting with a SameDB 
configuration 

If you are using Reporting, and you installed the InForm software and the Cognos Reporting 
software on the same application server, you must configure the Cognos software and reporting 
servers to use SSL. 
 

Configure Cognos 8 BI to use SSL—Reporting only 

Note: This step is required only if you are using Reporting.  

Use this procedure to update the Web Content URL and Gateway URI entries for SSL. Perform this 
procedure on the Cognos Gateway Server where the Cognos 8 BI Gateway services are installed. 

1 On the Cognos Gateway server, click Start > All Programs > Cognos8 > Cognos Configuration.  

2 After the Cognos Configuration utility is completely loaded, select Portal Services and update the 
Web Content URI entry: 
https://<servername>.<domainname>:<portnumber>/COGNOS8 

 

Note: Be sure to change the port number to the port for HTTPS. 

For example: 
https://example.north.com:443/cognos8 

 
3 Select Environment and update the Gateway URI entry: 

https://<servername>.<domainname>:<portnumber>/cognos8/cgi-
bin/cognosisapi.dll 

 

Note: Be sure to change the port number to the port for HTTPS. 

For example:  
https://example.north.com:443/cognos8/cgi-bin/cognosisapi.dll 

 
4 Select File > Save. 

The Cognos Configuration utility validates the settings and saves the configuration. 

5 When the checks are complete (all items are marked with a green check mark), click Close. 

6 Click Close, and close the Cognos Configuration utility window. 
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Configure the Cognos Gateway Server to use SSL—Reporting only 

Note: This step is required only if you are using Reporting and a public gateway.  

If you install Cognos 8 BI on its own dedicated server, you must configure IIS to work with 
Windows 2008. On the server where the Cognos 8 Business Intelligence Gateway services are 
installed: 

1 Navigate to Control Panel > Administrative Tools > Internet Information Services (IIS) Manager, and 
expand the node for the local computer. 

2 Select Web Service Extensions. 

3 Make sure that the following options are set to Allowed: 

• All Unknown CGI Extensions. 

• All Unknown ISAPI Extensions. 

• ASP.NET v1.1.4322. 

• ASP.NET v2.0.50727. 

• WebDAV. 

• Active Server Pages. 
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Enable SSL for each study 
If you choose to use SLL, you must enable SSL to be active for each study. 

After you complete the InForm installation and set up your environment to support SSL, you must 
enable the SSL System Configuration option for each study. You can set this option in the InForm 
Admin user interface or with the MedML Installer utility. 
 

Enable SSL through the InForm Admin user interface 
1 Log in to the InForm application as a user with system administration rights. 

2 Click Admin > Configuration. 

3 Set the Enable SSL option to on. 

4 If you are setting up the Reporting and Analysis module, change the Reporting service full url 
option to start with https:// and to include a port number. 

5 Click Update. 

6 Stop and restart the study with the following commands 
pfadmin stop trial <studyname> 
pfadmin start trial <studyname> 

 

Enable SSL with the MedML Installer utility 
1 Create an XML file with the following entry: 

<MEDMLDATA> 
<SYSCONFIG CONFIGNAME="SSLFLAG" TYPE="0" VALUE="1" />  
<MEDMLDATA/> 

 
2 If you are setting up the Reporting and Analysis module, include the following definition in the 

XML file, and change the value of URL for the reporting server to start with https://.  
<SYSCONFIG CONFIGNAME="REPORTINGSERVER" TYPE="0" VALUE="https://<url>" />  

 
3 Stop the study with the following command: 

pfadmin stop trial <studyname> 
 

4 Install the configuration options with the MedML Installer utility. 

5 Restart the study with the following command: 
pfadmin start trial <studyname> 
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Enable communication among distributed Cognos 8 BI 
software components 

If you install one or more Application Tier Components on a separate server, to ensure that they can 
communicate with other Cognos 8 BI reporting components: 

• Configure cryptographic properties. 

• Specify all Content Manager URIs. 

• Specify the Dispatcher URIs. 

• Specify the Dispatcher URI for external applications. 

• Configure the Cognos Report Server Notification Store property to point to the Content Store 
database. This is described in the online Help notes in the Cognos Configuration utility. 

Note: this is only necessary if you are using a multiple server environment where the 
Cognos Report Server and the Cognos Content Manager are on separate servers. 

For more information, see the Cognos 8 BI documentation. 
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Enable clinical model generation in a multi-server 
environment 

If your Cognos 8.4 environment contains multiple Cognos servers, set the following on all the 
dispatchers: 

1 Log in to the Cognos server using a Private Gateway. 

For more information about Private Gateways, see About the Cognos Private Gateway (on 
page 7) and Prepare the Cognos Gateway Server (on page 80). 

2 Select Launch > Reporting Administration. 

The Administration page appears. 

3 Click the Configuration tab.  

4 Click Dispatchers and Services.  

A list of the dispatchers that are registered with the Content Manager appears. 

5 For each dispatcher, perform these steps:  

a In the Actions column, click the Set Properties icon ( ). 

b Click the Settings tab.  

c Set the Load Balancing Mode property to Cluster Compatible. 

d Click OK. 
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Start the Cognos 8 BI servers 
After completing the Cognos 8 BI installation and configuration steps, you can start the Cognos 8 BI 
servers. If you have distributed Cognos 8 BI application tier components across multiple servers, see 
the Cognos Installation & Configuration Guide for the specific order for starting the servers. 

1 On the server where the Cognos 8 BI service is installed, select Start > All Programs > Cognos8 > 
Cognos Configuration.  

The Cognos Configuration utility starts. 

2 Select Actions > Start. 

3 When the server is started, close the Cognos Configuration utility. 
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Configure settings for Comma Separated Values (CSV) 
report output 

The Reporting and Analysis module provides settings that allow you to easily use CSV report output 
files with applications such as the Excel spreadsheet application. Oracle applies these settings for 
hosted environments, and recommends that you apply them to your environments as well.  

Note: You must have server administration rights to modify these settings. 

• Delimiter—Comma-delimited files are widely accepted for use with several applications. 

• Encoding—Using UTF-8 character encoding allows you to use your CSV output with a wide 
range of applications. 

• Terminator—Using carriage return and line feed (CRLF) terminators ensures that the report 
output is properly organized into columns and rows. 

 

Configure the CSV settings for reports 
1 Go to the Reporting and Analysis home page. 

2 Click Launch > Reporting Administration. 

The Administration page appears. 

By default, the Status tab is selected. 

3 In the pane on the left, click System. 

4 In the Scorecard section, click the server name. 

The full URL for the server appears below the server name. 

5 Click the full URL for the server. 

The available services for the server appear. 

6 Select Report Service > Set Properties. 

The Set properties - ReportService dialog box appears. 

7 Select the Settings tab. 

8 In the Category drop-down list, select Environment. 

9 In the Environment category, in the Advanced settings row, click Edit. 

The Set advanced settings dialog box appears. 

10 Select Override the settings acquired from the parent entry checkbox. 
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11 Type the following parameters and values: 
 

Parameter Value Description 
RSVP.CSV.DELIMITER , Separates each data item in the report output with 

a comma. 

RSVP.CSV.ENCODING UTF-8 Specifies UTF-8 character encoding for report 
data. 

RSVP.CSV.TERMINATOR CRLF Separates each row of data with a carriage return 
and line feed, so that the rows appear in ordered 
columns. 

 

12 Select the checkbox next to each parameter. 

13 Click OK. 

The Set properties - ReportService page appears. 

14 Click OK. 
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Deploy your study 
For information on deploying your study, see the Study and Reporting Setup Guide. The Study and 
Reporting Setup Guide describes how to perform the tasks that are required to set up an InForm study 
and configure the Reporting and Analysis module for the study. 
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About uninstalling software components 
This section describes how to uninstall the core InForm software, the Cognos 8 BI software, and the 
customizations for Cognos Reporting. For information about removing the reporting elements and 
an InForm study, see the Study and Reporting Setup Guide. 

Uninstall the InForm and Cognos 8 BI software in the following order: 

1 The Cognos Customization for InForm wizard, the Cognos Gateway Customization for InForm 
wizard, and the InForm Reporting Database scripts. 

2 The Cognos 8 software. 

3 The Oracle Directory Server. 

4 The InForm software. 
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Uninstalling the Cognos Customization for InForm and the 
Cognos Gateway Customization for InForm wizards 

To uninstall the files loaded with the Cognos Customization for InForm wizard, you uninstall the 
Cognos Gateway Customization for InForm wizard. 

1 On the server where the Cognos Gateway Customization software is installed, select Start > 
Control Panel > Programs and Features. 

2 Select the Cognos Gateway Customization for InForm entry, and click Uninstall. 

The Cognos Gateway Customization for InForm installation wizard starts. 

3 When the confirmation message appears, click Yes. 

4 When the wizard is complete, click Finish. 
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Uninstalling the Cognos 8 BI software 
The Cognos Uninstall Wizard enables you to uninstall the Cognos 8 BI core software and the 
Cognos 8 BI SDK software. You can uninstall both components together if they are on the same 
server or uninstall each component separately. 

1 On the server that hosts the Cognos 8 BI software, select Start > All Programs > IBM Cognos 8 - 64 
> Uninstall IBM Cognos 8 > Uninstall IBM Cognos 8. 

The Uninstall Wizard starts. 

2 On the Uninstall Language Selection page, select the language you want to use to run the 
uninstall, and click Next. 

3 On the next page, select the component packages to uninstall, and click Next. 

The uninstall process starts. 

4 When the wizard is complete, click Finish. 

Note: The uninstall may leave some folders and files on the computer. You can delete these with 
the Windows Explorer application. 

 



 Installation Guide  

InForm 6.0 127 

Uninstalling the Oracle Directory Server 
See the Oracle Directory Server Enterprise Edition documentation, or your Oracle database 
documentation for instructions on uninstalling the Oracle Directory Server. 
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Uninstalling the InForm software 
1 Stop all InForm servers and studies.  

2 Stop the InForm Service and the InForm Sync Service. 

3 Select Start > Control Panel > Programs and Features. 

4 Select Oracle InForm 6.0, and click Uninstall. 

A confirmation dialog box appears. 

5 Click Yes. 

6 If a message appears and asks if you want to remove shared files, click No to All. 

A message reminds you to back up customized files before continuing. 

7 To stop uninstalling the software so that you can back up the customized files, click No.  

or 

To continue, click Yes. 

When the uninstall is complete, the Reboot page appears.  

8 Click Finish. 

The computer reboots. 
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admindb 

Purpose 
Creates the InForm Admin database if you did not set it up during the InForm core software 
installation by selecting the Install Admin DB checkbox. 

Location 
<Installation_Directory>\InForm\bin\DBOra folder. 

Usage 
admindb [connection string] [/accountparams:"path_to_password_file"] 

 

Option Description 
/accountparams:"pat
h_to_password_file" 

When specified, includes the path to a text file that contains the user name 
and passwords required to run the command. 

If the accountparams option is not specified, the command prompts for the 
required user names and passwords. 

The format of the parameter file is parameter=value. There is a new line for 
each parameter, and there are no spaces on a line. 

 

Parameter file contents 
The following parameters are required for the admindb command password file: 

• pfdbauid=pfdbadmin user 

• pfdbapid=pfdbadmin password 

• admindbuid=informadmin user 

• admindbpid=informadmin password 

Example 
admindb trial1 /accountparams:"E:\scripts\adminpwd.txt" 
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configandcheckdiffdb 

Purpose 
Checks the variable settings in an environment where the study and reporting databases are in 
different database instances. 

Location 
Folder where the reporting software is located, for example, <Installation_Directory>\InForm 
Reporting\DBOra. 

Usage 
configandcheckdiffdb [/accountparams:"path_to_password_file"] 

 

Option Parameter 
/accountparams:"path_to_password_file" When specified, includes the path to a text file that 

contains the user name and passwords required to run 
the command. 

If the accountparams option is not specified, the 
command prompts for the required user names and 
passwords. 

The format of the parameter file is parameter=value. 
There is a new line for each parameter, and there are 
no spaces on a line. 

 

Parameter file contents 
The following parameters are required for the configandcheckdiffdb command password file: 

• trial_schema_owner_password=Password for the study schema owner. 

• dbauser_trial_password=Password for the study DBA user. 

• dbauser_rep_password=Password for the reporting DBA user. 

• streams_admin_user_rep_passwd=Password for the reporting streams admin user.  

• streams_admin_user_trial_pwd=Password for the study streams admin user. 

If the script passes with no errors, the variables are correct. If there is an error, make corrections and 
then rerun the script. Do not proceed with the installation until errors have been resolved. 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm Application Server. The scripts can also be run from the Oracle database home on an 
InForm Reporting Server. Running them from a different Windows Oracle client or from a non-
Windows Oracle client or database home may work, but is not supported. 
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configdiffdb.sql 

Purpose 
Contains reporting variables in an environment where the study and reporting databases are in 
different database instances. The reporting installation and uninstallation scripts use the 
configdiffdb.sql file for user name, password, tablespace, and connection information. 

Location 
Folder where the reporting software is located, for example, 
<Installation_Directory>\InForm\bin\DBOra\Reporting. 

Notes 
Before running and command that uses the configdiffdb.sql file (for example, configandcheckdiffdb), 
evaluate each user-defined variable, and change the values as needed to reflect your environment. 

Note: The configdiffdb.sql file cannot contain any passwords. 
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create_cap_table.sql 

Purpose 
Creates the TRIAL_URLS table for the PFCAPAdmin user. 

Location 
Folder where the reporting software is located, for example, 
<Installation_Directory>\InForm\bin\DBOra\Reporting. 

Usage 
@create_cap_table.sql 

Notes 
Run from SQL*Plus with /nolog. 

Errors are recorded in the create_cap_table.log file. 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm Application Server. The scripts can also be run from the Oracle database home on an 
InForm Reporting Server. Running them from a different Windows Oracle client or from a non-
Windows Oracle client or database home may work, but is not supported. 
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deinstall_reporting_diffdb 

Purpose 
Removes a single reporting schema when the study and reporting schemas are located in different 
database instances. This script: 

• Removes all components associated with the Reporting and Analysis module for a single study 
and reporting schema combination. 

• Uninstalls only one reporting schema at a time. To uninstall multiple reporting schemas, you can 
run the script as many times as necessary. 

• Does not remove the underlying reporting infrastructure, including reporting tablespaces. 

Location 
Folder where the reporting software is located, for example, 
<Installation_Directory>\InForm\bin\DBOra\Reporting. 

Usage 
deinstall_reporting_diffdb [/accountparams:"path_to_password_file"] 

 

Option Parameter 
/accountparams:"path_to_password_file" When specified, includes the path to a text file that 

contains the user name and passwords required to run 
the command. 

If the accountparams option is not specified, the 
command prompts for the required user names and 
passwords. 

The format of the parameter file is parameter=value. 
There is a new line for each parameter, and there are 
no spaces on a line. 

 

Parameter file contents 
The following parameters are required for the configandcheckdiffdb.sql command password file: 

• trial_schema_owner_password=Password for the study schema owner. 

• dbauser_trial_password=Password for the study DBA user. 

• dbauser_rep_password=Password for the reporting DBA user. 

• streams_admin_user_rep_passwd=Password for the reporting streams admin user.  

• streams_admin_user_trial_pwd=Password for the study streams admin user. 
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Notes 
Before running the deinstall_reporting_diffdb.sql script: 

• Review the parameters in the configdiffdb.sql file to make sure that they contain the same values 
that you used to install the reporting schema. For more information, see configdiffdb.sql (on 
page 132). 

• Stop the study. 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm Application Server. The scripts can also be run from the Oracle database home on an 
InForm Reporting Server. Running them from a different Windows Oracle client or from a non-
Windows Oracle client or database home may work, but is not supported. 
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grant_dba_privs.sql 

Purpose 
Grants DBA privileges to the rptinstall user, which is used for install and uninstall operations. 

Location 
Folder where the reporting software is located, for example, 
<Installation_Directory>\InForm\bin\DBOra\Reporting. 

Usage 
@grant_dba_privs.sql rptinstall 

Notes 
Log on to the study database as SYSDBA. 

The name of the DBA user must be rptinstall. 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm Application Server. The scripts can also be run from the Oracle database home on an 
InForm Reporting Server. Running them from a different Windows Oracle client or from a non-
Windows Oracle client or database home may work, but is not supported. 
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grant_user_privs.sql 

Purpose 
Grants database user privileges to the user that owns the study schema. 

Location 
Folder where the reporting software is located, for example, 
<Installation_Directory>\InForm\bin\DBOra\Reporting. 

Usage 
@grant_user_privs.sql <study schema owner> 

 

<study schema owner>—Database user name that holds the study schema. 

Example 
@grant_user_privs.sql pfst60uid 

Notes 
Run from SQL*Plus with /nolog. 

Connect to the study database as a user with the privilege to grant user database privileges. 

The script produces a log called grant_user_privs.log. 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm Application Server. The scripts can also be run from the Oracle database home on an 
InForm Reporting Server. Running them from a different Windows Oracle client or from a non-
Windows Oracle client or database home may work, but is not supported. 
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informprepora.vbs 

Purpose 
Creates the pfdbadmin user if you did not set it up during the InForm core software installation by 
selecting the Prep Oracle checkbox. 

Location 
<Installation_Directory>\InForm\bin\DBOra folder. 

Usage 
informprepora.vbs <oracle_connection_string> [/accountparams:"path_to_password_file"] 

 

Option Parameter 
/accountparams:"path_to_password_file" When specified, includes the path to a text file that 

contains the user name and passwords required to 
run the command. 

If the accountparams option is not specified, the 
command prompts for the required user names and 
passwords. 

The format of the parameter file is parameter=value. 
There is a new line for each parameter, and there are 
no spaces on a line. 

 

Parameter file contents 
The following parameters are required for the informprepora.vbs command password file: 

• orasys_user=<sys_userid> 

• orasys_user_pass=<password_for_sys_user> 

• pfdbauid=<pfadbadmin_userid>  

• pfdbapid=<pfdbadmin_password> 

Example 
informprepora trialdb /accountparams:"E:\scripts\prep.txt" 

Notes 
Set scripting to cscript to suppress popup messages. Type: 

cscript //H:cscript 
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install_reporting_diffdb 

Purpose 
Installs the Reporting and Analysis module in an environment where the study and reporting 
databases are in different database instances. 

Location 
Folder where the reporting software is located, for example, 
<Installation_Directory>\InForm\bin\DBOra\Reporting. 

Usage 
install_reporting_diffdb [/accountparams:"path_to_password_file"] 

 

Option Parameter 
/accountparams:"path_to_password_file" When specified, includes the path to a text file that 

contains the user name and passwords required to run 
the command. 

If the accountparams option is not specified, the 
command prompts for the required user names and 
passwords. 

The format of the parameter file is parameter=value. 
There is a new line for each parameter, and there are 
no spaces on a line. 
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Parameter file contents 
The following parameters are required for the install_reporting_diffdb.sql command password file: 

• trial_schema_owner_password=Password for the study schema owner. 

• rep_schema_owner_password=Password for the reporting schema owner 

• dbauser_trial_password=Password for the study DBA user. 

• dbauser_rep_password=Password for the reporting DBA user. 

• streams_admin_user_rep_passwd=Password for the reporting streams admin user.  

• streams_admin_user_trial_pwd=Password for the study streams admin user. 

• rep_proxy_user_password=The password for the user that exists in the trial database who has 
read-only access to the specified trial schema. 

Notes 
Before running the installation script, make sure that you have updated the study-specific variable 
settings with the configdiffdb.sql script. For more information, see configdiffdb.sql (on page 132). 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm Application Server. The scripts can also be run from the Oracle database home on an 
InForm Reporting Server. Running them from a different Windows Oracle client or from a non-
Windows Oracle client or database home may work, but is not supported. 
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mtsora102.vbs 

Purpose 
Sets up Oracle XA transaction support. During the InForm core software installation, if you check 
the Prep Oracle checkbox, the installation process sets up Oracle XA transaction support. If you do 
not set up Oracle XA transaction support during the installation, the mtsora102.vbs script enables 
you to set it up manually, during or after the Oracle installation. 

The mtsora102.vbs file does the following: 

1 Runs the XAVIEW.sql script as SYS to create the V$XATRANS$ view: 
%ORACLE_HOME%\RDBMS\ADMIN\XAVIEW.SQL 

 
2 Grants SELECT access to the public on these views: 

Grant Select on V$XATRANS$ to public 
Grant Select on sys.dba_pending_transactions to public 

 

Note: This example grants SELECT access to public, however in your environment SELECT 
access should be granted to the profile associated with your database. 

3 Modifies the following Registry keys in 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSDTC\Security 
"NetworkDtcAccess"=dword:00000001 
"NetworkDtcAccessAdmin"=dword:00000001 
"NetworkDtcAccessTransactions"=dword:00000001 
"XaTransactions"=dword:00000001 
"NetworkDtcAccessOutbound"=dword:00000001 
"NetworkDtcAccessInbound"=dword:00000001 
 

4 Modifies the following Registry key in 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSDTC\XADLL 
"mtxoci.dll"="C:\\WINDOWS\\system32\\mtxoci.dll" 

Location 
<Installation_Directory>\InForm\bin\DBOra folder. 
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Usage 
mtsora102.vbs <oracle_connection_string> <oracle_client_home_key> 
[/accountparams:"path_to_password_file"] 

 

Option Parameter 
/accountparams:"path_to_password_file" When specified, includes the path to a text file that 

contains the user name and passwords required to run 
the command. 

If the accountparams option is not specified, the 
command prompts for the required user names and 
passwords. 

The format of the parameter file is parameter=value. 
There is a new line for each parameter, and there are 
no spaces on a line. 

 

Parameter file contents 
The following parameters are required for the mtsora102.vbs command password file: 

• orasys_user=<sys_userid> 

• orasys_user_pass=<password_for_sys_user> 

Example 
cscript mtsora102.vbs dev1 KEY_OraClient10g_CLIENT1 /accountparams:"E:\scripts\mtsora.txt" 

Notes 
When setting up Oracle XA transaction support manually, run both the mtsora102.vbs script and the 
oramtsadmin.sql script. For more information, see oramtsadmin.sql (on page 143). 

Set scripting to cscript to suppress popup messages. Type: 

cscript //H:cscript 
 
For a more complete description, refer to one of the following articles: 

• Microsoft Knowledge Base—Q193893 – Info: Using Oracle with Microsoft Transaction 
Server and COM+. 

• MSDN Online Library—Setting up MTS to Access Oracle. 

• Microsoft KB Article 899191. 

• Microsoft KB Article 817066 and 891801 
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oramtsadmin.sql 

Purpose 
Creates the MTS administrative user and schedules automatic transaction recovery. You need to run 
oramtsadmin.sql only if you do not set up Oracle XA transaction support during installation of the 
InForm core software by selecting the Prep Oracle checkbox. If you set up Oracle XA transaction 
support manually, run oramtsadmin.sql after you run the mtsora102.vbs script. 

Location 
%ORACLE_CLIENT_HOME%\oramts\admin folder 

Usage 
@oramtsadmin.sql 

Notes 
Run as the SYS user as SYSDBA. 

Run the script against all Oracle instances connected to the InForm application server. 

Note: The InForm database installation and administration scripts are designed to be run using 
the InForm Application Server. The scripts can also be run from the Oracle database home on an 
InForm Reporting Server. Running them from a different Windows Oracle client or from a non-
Windows Oracle client or database home may work, but is not supported. 
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pfadmin 

Purpose 
Sets up the InForm server environment. The parameters are stored in the registry. Therefore, you 
need local administrator privileges to run the utility. 

Location 
<Installation_Directory>\InForm\bin\DBOra folder. 

Usage 
pfadmin [ CHECKREG | CONFIG | CREATEREPORTINGMODEL | HELP | KILLSERVER 
| PING | PUBLISHREVIEWSCHEMA | RECREATEREVIEWSCHEMA | REMOVE | 
RECREATEREPORTINGSCHEMA | SETSERVER | SETUP | SETLANGUAGE | START | 
STOP | UNINSTALL | VIEW ] [/accountparams:"path_to_password_file"] 

 

pfadmin command options 

Option Purpose and Syntax 
CHECKREG [/Del] [/DelAll] Displays the current InForm Server COM and MTS 

components in the NT registry.  

WARNING: Be careful to remove the server(s) or 
uninstall the service before using either of the delete 
options: 

• [/Del]—Removes obsolete settings. 

• [/DelAll]—Removes the settings of all servers. 
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pfadmin command options 

Option Purpose and Syntax 
CONFIG Service  
 [/AdminDB DBServer ] | 
 [/AdminDSN DsnName ] | 
[ /AdminDN ] 
 [/PfUser ] | 
 [/SysDBA ]  

Configures an existing service. 

• [/AdminDB DBServer [SQL]]—Sets the ODBC DSN 
for the InformAdmin database. Make sure that 
DBServer, UID, and PID are the same ones that were 
used to create the InformAdmin database. Use 
alphabetic or alphanumeric characters for the UID and 
PID, and begin them with a letter; do not use all 
numeric characters. 

• [/AdminDSN DsnName ]—Creates the ODBC DSN 
InForm software with the default database server, 
using the specified user name and password. Use 
alphabetic or alphanumeric characters for the UID and 
PID, and begin them with a letter; do not use all 
numeric characters. 

• [/PfUser]—Creates the PfUser_computername account 
during the InForm software installation. The account 
is for Microsoft MTS packages used by InForm 
servers. In general, you do not need to configure the 
account. If you change the password through NT User 
Manager, you must reconfigure the InForm Service 
with the new password. 

• [/SysDBA ]—Sets the InForm Service DBA user 
name and password. You can use this command to 
change the pfdbadmin password as needed. 

If you want to change the InForm Service DBA name, 
modify the provided SQL script InFormPrepORA.sql 
with the new user name and password, then run the 
script as SYS. After running the script, use this 
command option to configure the InForm Service to 
use the new InForm Service DBA. 

Use alphabetic or alphanumeric characters for the 
UID and PID, and begin them with a letter; do not use 
all numeric characters. 

CONFIG Server ServerName 
 [Automatic|Manual] 

Configures the startup mode for an existing server as either 
Automatic or Manual. 
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pfadmin command options 

Option Purpose and Syntax 
CONFIG Trial TrialName 
 [Automatic | Manual] | 
 [/TriDSN DSN | 
 [/RndDSN DSN] | 
 [/RndDSN DSN] | 
 [/Rnd [MDBFilePath ]] | 
 [/Rnd [MDBFilePath ] ] | 
 [/Host ServerName]  

Configures an existing study. 

• [Automatic | Manual]—Configures the study startup 
mode. 

• [/TriDSN DSN ]—Configures the study ODBC DSN. 
Use alphabetic or alphanumeric characters for the 
UID and PID, and begin them with a letter; do not use 
all numeric characters. 

• [/RndDSN DSN]—Configures the study 
randomization source dataset name. Use when setting 
up a Microsoft randomization source database. 

• [/RndDSN DSN ]—Configures the study 
randomization source dataset name. Use when setting 
up an Oracle randomization source database. Use 
alphabetic or alphanumeric characters for the UID and 
PID, and begin them with a letter; do not use all 
numeric characters. 

• [/Rnd [MDBFilePath]]—Creates a study randomization 
source dataset name to use the given Microsoft Access 
database file. 

• [/Rnd [MDBFilePath] ]—Creates a study 
randomization source dataset name to use the given 
Oracle database file. Use alphabetic or alphanumeric 
characters for the UID and PID, and begin them with 
a letter; do not use all numeric characters. 

• [/Host ServerName]—Moves the study from current 
host server to another server in the InForm Service. 

CONFIG CDD TrialName 
 [Enable | Disable] | 
 [DSN [Active | Inactive]] | 
 [DSN StudyLocale]  

Configures an existing CDD: 

• [Enable | Disable]—Enables or disables the CDD for 
a particular study. 

• [DSN [Active | Inactive]]—Makes a CDD DSN active 
or inactive for a particular study. 

• [DSN StudyLocale]—Specifies the study locale used for 
the unit symbol translation that is stored in the CDD 
column for the unit symbol. 

• path_to_dsn_password_file—Configures an existing CDD 
DSN with the User ID and password specified. Use 
alphabetic or alphanumeric characters for the UID and 
PID, and begin them with a letter; do not use all 
numeric characters. 
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pfadmin command options 

Option Purpose and Syntax 
CONFIG WEBSERVICE TrialName  
WebServiceName [Add | Remove] 

Associates a web service with a study. 

• WebServiceName—ODMSubmitService 

• [Add | Remove]—Creates or removes an association 
between a study and a web service 

CREATEREPORTINGMODEL 
TrialName  

Creates the Reporting model from scratch. 

HELP Lists all the options of the pfdamin command. 

KILLSERVER ServerName Stops server MTS packages without stopping studies on 
the server. 

PING MachineName  
 1 | 2 | 3:ServerName | 4:ServerName | 
5:ServerName [Port#] 

Pings the InForm Service or a particular server. The ping 
levels are: 

• 1—Ping the InForm Service. 

• 2—Ping the InForm Service and all InForm server(s). 

• 3—Ping the specified server. 

• 4—Ping and get information about the specified 
server. 

• 5—Ping the specified server and dump the user 
session to a server-side file. 

• [Port#]—Allows you to specify the port number the 
echo server is listening on, if you changed it.  

PUBLISHREVIEWSCHEMA 
TrialName [/FORCE] 

Applies all study version changes to the review schema 
clinical tables. 

If you use the /FORCE option, the InForm application 
does not check to see if there are study version changes 
that are not applied, and makes sure all study version 
changes are applied.  

Note: The /FORCE option does not drop and re-create 
the clinical tables. It makes the clinical tables match the 
study version. The /FORCE option should only be used if 
recommended by Oracle.  
 
This operation is synchronous. The study is unavailable 
during the operation. 

RECREATEREVIEWSCHEMA 
[TrialName StudyLocale_ISO_name] 

Changes the Review Schema study locale.  

The Review schema study locale is chosen automatically 
when a trial is first installed, but can be changed using this 
command. 
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pfadmin command options 

Option Purpose and Syntax 
REMOVE 
 [Server ServerName] | 
 [Trial TrialName [/DSN]] | 
 [CDD TrialName [/All | DSN] 
 

Removes an existing server, study, or CDD. 

• [Server ServerName]—Removes an InForm server from 
the InForm Service. Studies should be either 
reconfigured to other servers or removed before this 
command is run. 

• [Trial TrialName [/DSN]]—Deletes the named study 
from the InForm Service. The Web virtual directories 
and folders for the study are physically removed. Use 
the /DSN option to remove the study-related DSNs. 

• [CDD TrialName [/All | DSN]—Removes either all 
CDD DSNs in the specified study or the given CDD 
by DSN. 

Note: Before using the PFADMIN REMOVE command, 
verify that IIS is running. 
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pfadmin command options 

Option Purpose and Syntax 
SETSERVER 
[Site TrialName MachineName] | 
[MedMLInstaller TrialName 
MachineName] | 
[Reporting TrialName ReportingUrl] | 
[ReportingAN TrialName 
AuthenticationNamespace] | 
[ReportingUR TrialName UserRoot] | 
[ReportingInt TrialName 
ReportingInternalURI] | 
 [pfreportinguserpw TrialName] |  
[systempw TrialName]  

Changes the MedML and Site servers and sets the 
Reporting configuration settings 

• [Site TrialName MachineName]—Not supported. 

• [MedMLInstaller TrialName MachineName]—Not 
supported. 

• [Reporting TrialName ReportingUrl]—Set Cognos 8 BI 
URL for study. 

• [ReportingAN TrialName AuthenticationNamespace]—Set 
Cognos 8 BI AuthenticationNamespace for study.  

• [ReportingUR TrialName UserRoot]—Set Cognos 8 BI 
UserRoot for study.  

• [ReportingInt TrialName ReportingInternalURI]—Set 
the internal URI that the InForm server uses to 
communicate with the Cognos 8 BI server. 

• [pfreportinguserpw TrialName]—Run this pfadmin 
command after the password for the pfreportinguser is 
changed in the InForm user interface to set a property 
used by Reporting when it needs the credentials of the 
pfreportinguser user for building the model. 

pfreportinguser is the preferred studyuser to run 
pfrinit to configure Cognos for each study. 

• [systempw TrialName]—Set the password for the 
system user for the specified study. The command also 
activates the system user. 

Note: The SETSERVER command requires that you set 
the Default Authentication Level property of the InForm 
server to Connect: 

To set this property: 

1 Select Administrative Tools > Component Services > My 
Computer - Properties. 

2 Set the Default Properties - Default distributed 
communication properties - Default Authentication Level 
value to Connect. 

SETUP Server ServerName [Automatic] Creates a new InForm server in the InForm Service. 

• [Automatic]—The server is automatically started with 
the InForm Service. Manual startup is the default. 
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pfadmin command options 

Option Purpose and Syntax 
SETUP Trial TrialName ServerName 
 [/DB OracleConnStr] |  
 [/DSN TriDSN [Automatic]  

Creates a study on the given InForm server with the 
option to either create a new ODBC DSN or use an 
existing one. The server has to be created. The study 
startup mode is Manual by default. Use the Automatic 
option to automatically start the study when the InForm 
server that hosts the study is started. 

• [/DB OracleConnStr UID PID]—Creates an ODBC 
DSN TrialName with the given ServerName, UID, and 
PID. Use alphabetic or alphanumeric characters for the 
UID and PID, and begin them with a letter; do not use 
all numeric characters. 

• [/DSN TriDSN UID PID [Automatic]]—Configures 
the created study TrialName to use the given study 
dataset name TriDSN, UID, and PID. The study must 
be present in the ODBC DSN. Use alphabetic or 
alphanumeric characters for the UID and PID, and 
begin them with a letter; do not use all numeric 
characters. 

Note: Before using the /DSN command, verify that IIS is 
running. 

SETUP CDD RefName TrialName  
 /DB OracleConnStr DSN  
 [/TBSP OraTBSP] [Active] 
[NoSchema] 

Sets up a new CDD DSN associated with the given CDD 
refname. Use alphabetic or alphanumeric characters for the 
UID and PID, and begin them with a letter; do not use all 
numeric characters. 

• [/TBSP OraTBSP]—Defines the Oracle tablespace for 
the CDD schema. 

• [Active]—Specifies that the DSN is transactional. 

• [NoSchema]—Indicates that no new CDD schema 
should be created during setup. The existing database 
is not touched. By default, the user is dropped and the 
Oracle database destroyed. Then, a new schema is 
created and populated based on the RefName that 
defines the schema. 

Note: To execute this command successfully, the study 
must be started. 
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pfadmin command options 

Option Purpose and Syntax 
SETUP CDD RefName TrialName  
 /DSN DSN [/TBSP OraTBSP] 
[Active] [NoSchema] 

Sets up an existing DSN associated with the given CDD 
RefName. Use alphabetic or alphanumeric characters for 
the UID and PID, and begin them with a letter; do not use 
all numeric characters.[/TBSP OraTBSP]—Defines the 
Oracle tablespace for the CDD schema. 

• [Active]—Makes the DSN transactional. 

• [NoSchema]—Indicates that no new CDD schema 
should be created during setup. The existing database 
is not touched. By default, the user is dropped and the 
Oracle database destroyed. Then, a new schema is 
created and populated based on the RefName that 
defines the schema. 

Note: To execute this command successfully, the study 
must be started. 

SETLANGUAGE 

[IsoLanguageName] 

| en-US | ja-JP | 

Sets the InForm product locale language. en-US and ja-JP 
are currently supported. 

START  
 [Server ServerName] | 
 [Trial TrialName] 

Starts an existing InForm server or study. 

• [Server ServerName]—Starts an existing InForm server 
by server name. 

• [Trial TrialName]—Starts an existing study by study 
name. 

START 
 [Trial TrialName [/Design]] 

Starts the study in design mode. This means you can install 
study components that are not completely designed (strict 
checking is not in force). By default, the study starts in 
production mode. 

STOP  
 [Server ServerName [/Trials]] | 
 [Trial TrialName [/Anyway]] 

Stops an existing InForm server or study. 

• [Server ServerName [/Trials]]—Stops an existing 
InForm server by server name. By default, a running 
server can be stopped if there is no study running and 
no other application connected to it. The Trials 
keyword stops all running studies, and then stops the 
server. 

• [Trial TrialName [/Anyway]]—Stops the named study. 
The Anyway keyword stops a study regardless of any 
connections or HTTP requests. 
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pfadmin command options 

Option Purpose and Syntax 
UNINSTALL Removes all InForm servers and studies, and then removes 

the InForm service settings PfUser_computername and the 
MTS library package.  

Note: The InForm service must be running for the 
command to work. 

VIEW  
 [Languages] | [Service] | 
 [Server ServerName] | 
 [Trial TrialName] | 
 [CDD TrialName] | [Reporting 
TrialName] 

Displays a monitoring list of all servers in the InForm 
service, all studies in servers, or all RefNames for CDD 
DSNs configured for a study. 

• [Languages]—Lists installed languages without starting 
the InForm Service. 

• [Service] 

 Lists all the servers and studies in the InForm 
service. 

 Lists installed product languages as well as the 
actual installed product language. 

• [Server ServerName]—Lists each server by server name 
and studies hosted on that server. 

• [Trial TrialName]—Lists a study by its name. 

• [CDD TrialName]—Lists the RefNames for each CDD 
DSN configured for the specified study. 

• [Reporting TrialName]—Lists the current status of 
Reporting. 

 States whether the study is configured for 
Reporting. 

 Specifies the type of reporting setup: samedb or 
diffdb. 

 Specifies the reporting username. 

 Gives the date of the last Cognos model update. 

 Reports if the Reporting database is up-to-date. 

 States whether Oracle streams are working 
properly (if applicable). 
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pfadmin command options 

Option Purpose and Syntax 
/accountparams:"path_to_password_file" When specified, includes the path to a text file that 

contains the user name and passwords required to run the 
command. 

If the accountparams option is not specified, the command 
prompts for the required user names and passwords. 

The format of the parameter file is parameter=value. There 
is a new line for each parameter, and there are no spaces 
on a line. 

Parameter file contents 
The following parameters are required for the pfadmin command password file: 

 

Command Parameters 
• pfadmin setup trial 

• pfadmin setup cdd 

• pfadmin config cdd 

• pfadmin config service /sysdba 

• pfadmin config service /admindsn 

• pfadmin config service /pfuser 

• pfadmin config trial 

uid=user name 

pid=password 

• pfadmin setserver reportingdiffdbpw 

• pfadmin setserver pfreportinguserpw 

• pfadmin setserver systempw 

pid=password 
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Examples 
Check the status of InForm Reporting: 

pfadmin view reporting pfst60 
 

Check the status of InForm servers and studies on an InForm Service: 

pfadmin view service 
Start the demo InForm server: 

pfadmin start server demo 
 

Start the pfst60 study: 

pfadmin start study pfst60 
 

Stop all studies running on the demo InForm server, and then stop the demo server: 

pfadmin stop server demo /Trials 
 

Set the password and activate the system user account: 

pfadmin setserver systempw pfst60 /accountparams:"E:\scripts\pwd.txt" 
 

Notes 
Any arguments containing commas, equal signs, or spaces must be enclosed within double quotes. 
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pfcognosconfig 

Purpose 
Configures an InForm study to work with Cognos 8 BI. The PFCognosConfig utility is a command-
line alternative to the InForm Reporting Configuration Wizard.  

PFCognosConfig can be run multiple times to change reporting parameters. If the reporting study 
user password changes, PFCognosConfig.exe must be run to tell InForm about the new password. 

When PFCognosConfig is run multiple times for a study, each run after the first need not specify all 
the parameters – only the changed parameters need be specified. 

Location 
<Installation_Directory>\InForm\bin\DBOra folder. 

Usage 
pfcognosconfig "path_to_password_file" 

 

Option Parameter 
path_to_password_file When specified, includes the path to a text file that 

contains the user name and passwords required to run 
the command. 

If the parameter file is not specified, the command 
prompts for the required user names and passwords. 

The format of the parameter file is parameter=value. 
There is a new line for each parameter, and there are 
no spaces on a line. 

 

Parameter file contents 
The following parameters are required for the pfcognosconfig command password file: 

 

Option Description 
trialname=<studyname> Name of the InForm study. 

Note: Use the same case as when the study was created 
by the Central Designer deployment package. 

log_file=<outputlog> Name of output log. Example: nocreatorgcap.log. 
(Optional). 
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Option Description 
namespace=<cap_namespace> Custom Authentication Provider (CAP) namespace. The 

default is informcap. The case of the value you enter here 
must be the same case as the entry in the Cognos 
Configuration utility. For example, if the entry in the 
Cognos Configuration utility is in lower case (informcap), 
the <namespace> option must also be informcap. 

Users can create additional namespaces manually in the 
Cognos Configuration tool. In this case, the name of the 
newly created namespace should be used in this field. 

gateway_uri=<gateway_uri> External public URI that communicates with the Cognos 
8 BI Gateway Services from an end user's browser. This 
Cognos parameter is set in the Cognos 8 BI Gateway 
Customization for InForm wizard. The parameter setting 
is stored in the cogstartup.xml file.  

Example: http:example.north.com/cognos8 

dispatcher_uri=<dispatcher_uri> Internal URI that the InForm server uses to communicate 
with the Cognos 8 BI server. This Cognos parameter is 
set in the InForm CRN wizard. The parameter setting is 
stored in the cogstartup.xml file and corresponds to the 
Reporting internal URI value on the Admin > System 
Configuration page of the InForm application. 

Example: 
http://example.north.com:9300/p2pd/servlet/dispatch. 

root_folder=/<content>/<folder>[@na
me='<studyname>'] 

The top-level reporting folder for the company. Default: 

/content/folder[@name='<studyname>'] 

reporting_samedb=<true | false> True if the study and the Reporting database are on the 
same server. 

reporting_diffdb_server=<servername> Reporting database connection string (TNS Name). Use if 
Reporting and the InForm study are in different 
databases. 

reporting_diffdb_pass=<rptpid> Reporting Trial password (reporting database study 
username must be the same as the InForm database study 
username, so the username need not be specified). Use if 
the study and the Reporting database are in different 
databases. 

trial_web_service=<URL> InForm authentication web service URL. This is a 
required parameter. 

register_db_server=<ServerName> Name of the server in which the study is registered with 
Cognos.  

register_db_user=<UserName> Study database user registered with Cognos. 

register_db_pass<UserPassword> Password for the database user registered with Cognos. 
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Example: 

Example command-line with a complete set of parameters to set up reporting DiffDB: 

pfcognosconfig "E:\scripts\pfconfigparams.txt" 
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pfrinit 

Purpose 
Performs the following tasks: 

• Modifies the default Cognos 8 BI capabilities to fit the InForm reporting environment. 

• Creates new Cognos 8 BI groups that match InForm reporting requirements. 

• Sets Public folders permissions so that only Publishers can write to this public area. 

• Maps study-specific reporting groups to the Cognos 8 BI groups and roles. 

• Creates study-specific data connection and set permissions so that it is restricted for the use of 
study members only. 

• Copies the  InForm Trial Management (ITM) package present in the InForm folder and renames 
it as a study-specific ITM package. 

• Creates a study folder that contains all the standard folders and reports that point to the study-
specific package. Relative paths within reports will be modified to reflect the new location. 

• Validates all copied reports so that all successfully validated reports are syntactically correct and 
able to run against the study-specific packages. 

Location 
The InForm Application Server folder of the server where the Cognos Application Tier components 
are installed. For example, <Installation_Directory>\InForm\bin. 

Usage 
pfrinit "path_to_password_file" 

 

Option Parameter 
path_to_password_file When specified, includes the path to a text file that 

contains the user name and passwords required to run 
the command. 

If the parameter file is not specified, the command 
prompts for the required user names and passwords. 

The format of the parameter file is parameter=value. 
There is a new line for each parameter, and there are 
no spaces on a line. 

 



 Installation Guide  

InForm 6.0 159 

The recommended InForm study user for running pfrinit is pfreportinguser. You can change the 
password for this user using the InForm user interface as with any other user. After you change the 
password, however, you must run the PFADMIN command, using this syntax: 

PFADMIN SETSERVER PFREPORTINGUSERPW <studyname> 

When prompted, enter the pfreportinguser password. 

This command sets a property used by Reporting when it needs the credentials of the 
pfreportinguser. 

For more information, see pfadmin (on page 144). 

Parameter file contents 
The following parameters are required for the pfrinit command password file: 

• sysadmin_namespace=Oracle Directory Server admin namespace. Type ORACLEHS (case-
sensitive). 

• sysadmin_uid=User name for the Oracle Directory Server admin namespace. Type 
crnsysadmin. 

• sysadmin_pass=<crnsysadmin_password> Password you chose when creating the crnsysadmin user. 

• publisher_namespace=Custom Authentication Provider (CAP) namespace. The default is 
informcap.  

Note: The case of the value you enter here must be the same case as the entry in the 
Cognos Configuration utility. For example, if the entry in the Cognos Configuration utility is 
in lower case (informcap), the <namespace> option must also be informcap. 

• publisher_uid=InForm_study_user>InForm study user who is a member of the following 
Reporting groups: 

• Publishers. 

• Either Sponsor Users or Site Users. 

pfreportinguser is the recommended study user to run pfrinit. This is user is created during 
Reporting and Analysis installation. 

• publisher_pass=Password of the InForm study user. 

• displatcher_url=Internal URI that the InForm server uses to communicate with the Cognos 8 BI 
server. This Cognos 8 BI parameter is set in the InForm CRN wizard. The parameter setting is 
stored in the cogstartup.xml file and corresponds to the Reporting internal URI value on the 
Admin > System Configuration page of the InForm application. 

Example: http://<machine_FQDN>:9300/p2pd/servlet/dispatch. 
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• trial_name=Name of the InForm study. 

Note: Use the same case as when the study was created by the Central Designer 
deployment package. 

• reportdb_pass=Password for the reporting schema user. 

Example 
pfrinit "E:\scripts\init.txt" 
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remove_streams_setup_info_diffdb 

Purpose 
Deletes stream information from the study database and reporting database. 

Location 
Folder where the reporting software is located, for example, <Installation_Directory>\InForm 
Reporting\DBOra. 

Usage 
remove_streams_setup_info_diffdb [/accountparams:"path_to_password_file"] 

 

Option Parameter 
/accountparams:"path_to_password_file" When specified, includes the path to a text file that 

contains the user name and passwords required to run 
the command. 

If the accountparams option is not specified, the 
command prompts for the required user names and 
passwords. 

The format of the parameter file is parameter=value. 
There is a new line for each parameter, and there are 
no spaces on a line. 

 

Parameter file contents 
The following parameters are required for the remove_streams_setup_info_diffdb command 
password file: 

• streams_admin_user_rep_passwd=Password for the reporting streams admin user.  

• streams_admin_user_trial_pwd=Password for the study streams admin user. 

Example 
remove_streams_setup_info_diffdb /accountparams:"e:\scripts\streampwds.txt" 
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Install issues 

Oracle MTS configuration is invalid 
If the Oracle registry settings are not correct, you may get the following InForm core installer errors 
during the installation process: 

• Oracle MTS configuration is invalid. 

• Registry Settings: INVALID. 

• XA Views: INVALID. 

Possible solutions: 

• If the installation wizard is still open: 

1 Click Back to display the Database Configuration window. 

2 Select the Prep Oracle checkbox. 

3 Click Next to proceed.  

This runs the informprepora.vbs and mtsora102.vbs scripts. 

• If the installation window has been closed, run mtsora102.vbs from the command line. The 
mtsora102.vbs file is in the InstallSupport folder of the InForm installation image. 

 

XA Views: INVALID 
If you have tried the solution that is recommended in Oracle MTS configuration is invalid and still get 
this error, or if you run mtsora102.vbs from the command line and get a warning, the xaview.sql file 
may not be installed. 

Note: This can happen for some Oracle client-only installations (multi-tier setup). 

Possible solution: 

1 Copy the xaview.sql file from another machine (running the same Oracle version) to your Oracle 
rdbms\admin directory. 

2 Log in as SYS on a machine with xaview.sql. 

3 Run xaview.sql against your InForm core instance. 

4 Run mtsora102.vbs from the command line. 
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Database connectivity 
If you get a warning about database connectivity, make sure that: 

• The connect string value is correct. 

• The pfdbadmin password is valid. 

If you get a message that the pfdbadmin user does not exist, create the user by doing one of the 
following: 

• Select the Prep Oracle checkbox in the InForm installation wizard. 

• Run the informprepora.vbs script located in the InstallSupport folder of the InForm installation 
image. 

 

Password error on InForm service start up 
The InForm installation wizard cannot ensure that the password entered on the Account 
Configuration Window for the Local Machine User (pfUSR) meets the password requirements set 
for the machine. If you enter a password that does not conform to the Windows password 
requirements, an error will prevent the InForm service from starting. 

1 To change the pfUser password enter the following command at a DOS prompt: 

pfadmin install 

2 When prompted for the pfUSR password, enter a password that meets the password 
requirements. 

3 Run the following command to start the InForm service: 

new start pfservice 

Use the pfadmin view service command to verify that the InForm service has started. 
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Uninstall issues 

Errors when removing a reporting schema 
If you run the deinstall_reporting_diffdb.sql script to remove a reporting schema, and you receive 
the message Reporting deinstallation aborted, the uninstall fails and no reporting objects are 
removed. 

The probable cause is a problem with the settings in the configdiffdb.sql file. 

Check the configdiffdb.sql file to make sure that the settings are correct for the reporting schema 
that you want to remove. In particular, the uninstall scripts check for the existence of a tablespace. If 
the configdiffdb.sql file contains variables that refer to nonexistent tablespaces, update the file and 
rerun the uninstall script. 
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Steps for running the Cognos Customization wizards in 
silent mode 

For implementations with multiple machines running the Cognos Content Manager, the Cognos 
Report Server and the Cognos Gateway Server, you can run the Cognos Customizations in silent 
mode. 

To run the CRNConfig and CRNGatewayConfig setup wizards in silent mode: 

1 Copy the CRNConfig and CRNGatewayConfig folders from the product image to a location that is 
accessible to the machines where you will run the wizards.  

2 Populate the setup.iss files in each folder with the options you want to specify for the 
CRNConfig and CRNGatewayConfig wizards. 

You can edit the setup.iss files manually, or you can run the each customization wizard in record 
mode. 

For more information, see: 

• Run the Cognos Customization for InForm wizard (CRNConfig\setup.exe) in record 
mode (on page 169). 

• Run the Cognos Gateway Customization for InForm wizard 
(CRNGatewayConfig\setup.exe) in record mode (on page 171). 

3 Run the configuration wizards in silent mode. 

For more information, see: 

• Run the Cognos Customization for InForm wizard (CRNConfig\setup.exe) in silent 
mode (on page 170). 

• Run the Cognos Gateway Customization for InForm wizard 
(CRNGatewayConfig\setup.exe) in silent mode (on page 172). 
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Run the Cognos Customization for InForm wizard (CRNConfig\setup.exe) in 
record mode 

1 Run the Cognos Customization for InForm wizard (CRNConfig\setup.exe) to install the 
customizations for the Cognos Content Manager Server or the Cognos Report Server. 

For more information, see Run the Cognos Customization for InForm wizard 
(CRNConfig\setup.exe)—Cognos Content Manager / Cognos Report Server (on page 
92). 

2 Open a Command Prompt window, and use the following command to run the Cognos 
Customization for InForm wizard in record mode. 

This step records the installation options, and creates the setup.iss response file that you can use 
to run the wizard again in silent mode, on other machines 
CRNConfig\setup.exe -r  
-f1<path_to_configuration_files>\CRNConfig\setup.iss 
 

 

Parameter Description 
-r Runs the wizard in record mode. The options you select when the wizard runs 

are saved in the response file (setup.iss) identified by the -f1 parameter. 

-f1 Identifies the location of the response file. There is no space between the -f1 
flag and the response file location. For example: 
 -f1E:\ReportingInstallFiles\CRNConfig\setup.iss. 
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Run the Cognos Customization for InForm wizard (CRNConfig\setup.exe) in 
silent mode 

1 Copy the CRNConfig folder from the product image to a location that is accessible to the 
machines where you will run the wizard.  

2 Populate the setup.iss file in the folder with the options you want to specify for the Cognos 
Customization for InForm wizard. 

You can edit the setup.iss files manually, or you can run the customization wizard in record 
mode. For more information, see Run the Cognos Customization for InForm wizard 
(CRNConfig\setup.exe) in record mode (on page 169). 

3 Open a Command Prompt window, and run the following command: 
CRNConfig\setup.exe -s  
-f1<path_to_configuration_files>\CRNConfig\setup.iss 
-f2<path_to_configuration_files>\CRNConfig\setup.log 

 

Parameter Description 
-s Runs the wizard in silent mode. 

-f1 Identifies the location of the response file that contains the options for the 
wizard. There is no space between the -f1 flag and the response file location. 
For example: 
-f1E:\ReportingInstallFiles\CRNConfig\setup.iss 

-f2 Identifies the location of the log file for the wizard. There is no space between 
the -f1 flag and the log file location. For example: 
-f1E:\ReportingInstallFiles\CRNConfig\setup.log 
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Run the Cognos Gateway Customization for InForm wizard 
(CRNGatewayConfig\setup.exe) in record mode 

1 Run the Cognos Gateway Customization for InForm wizard (CRNGateway Config\setup.exe) 
to install the customizations for the Cognos Gateway Server. 

For more information, see Step 3: Run the Cognos Gateway Customization for InForm 
wizard (CRNGatewayConfig\setup.exe) on the Cognos Gateway Server (on page 82). 

2 Open a Command Prompt window, and use the following command to run the Cognos 
Gateway Customization for InForm wizard in record mode. 

This step records the installation options, and creates the setup.iss response file that you can use 
to run the wizard again in silent mode, on other machines 
CRNGatewayConfig\setup.exe -r 
-f1<path_to_configuration_files>CRNGatewayConfig\setup.iss 
 

 

Parameter Description 
-r Runs the wizard in record mode. The options you select when the wizard runs 

are saved in the response file (setup.iss) identified by the -f1 parameter. 

-f1 Identifies the location of the response file. There is no space between the -f1 
flag and the response file location. For example: 
 -f1E:\ReportingInstallFiles\CRNConfig\setup.iss. 
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Run the Cognos Gateway Customization for InForm wizard 
(CRNGatewayConfig\setup.exe) in silent mode 

1 Copy the CRNGatewayConfig folder from the product image to a location that is accessible to the 
machine where you will run the wizard.  

2 Populate the setup.iss file in the folder with the options you want to specify for the Cognos 
Gateway Customization for InForm wizard. 

You can edit the setup.iss file manually, or you can run the customization wizard in record mode. 
For more information, see Run the Cognos Gateway Customization for InForm wizard 
(CRNGatewayConfig\setup.exe) in record mode (on page 171). 

3 Open a Command Prompt window, and run the following command: 
CRNConfig\setup.exe -s  
-f1<path_to_configuration_files>\CRNConfig\setup.iss 
-f2<path_to_configuration_files>\CRNConfig\setup.log 

 

Parameter Description 
-s Runs the wizard in silent mode. 

-f1 Identifies the location of the response file that contains the options for the 
wizard. There is no space between the -f1 flag and the response file location. 
For example: 
-f1E:\ReportingInstallFiles\CRNConfig\setup.iss 

-f2 Identifies the location of the log file for the wizard. There is no space between 
the -f1 flag and the log file location. For example: 
-f1E:\ReportingInstallFiles\CRNConfig\setup.log 
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